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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a
condition fully complying with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you have any questions
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer
them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any intention other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and a basic knowledge of English. It is therefore essential that only
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at
the appropriate place in the product documentation. Keep the basic safety instructions and the product
documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories.

Symbols and safety labels

A A&AMNAASG BN L

Notice, general Caution Danger of Warning! PE terminal Ground Ground Be careful when
danger location when electric Hot surface terminal handling
handling shock electrostatic
Observe prqduct heavy sensitive
documentation equipment devices

| O 0 == ~ ~ N

ON/OFF supply | Standby Direct current Alternating current | Direct/alternating | Device fully protected by
voltage indication (DC) (AC) current (DC/AC) double (reinforced) insulation

1171.0000.42-05.00 Page 1



Basic Safety Instructions

Tags and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks
and dangers.

indicates a hazardous situation which, if not avoided, will result in death or
A DANGER serious injury.

indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A WARNING

indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

indicates the possibility of incorrect operation which can result in damage to
NOTICE the product.

In the product documentation, the word ATTENTION is used synonymously.

A CAUTION

These tags are in accordance with the standard definition for civil applications in the European Economic
Area. Definitions that deviate from the standard definition may also exist in other economic areas or
military applications. It is therefore essential to make sure that the tags described here are always used
only in connection with the related product documentation and the related product. The use of tags in
connection with unrelated products or documentation can result in misinterpretation and in personal injury
or material damage.

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level,
max. transport altitude 4500 m above sea level. A tolerance of +10 % shall apply to the nominal
voltage and £5 % to the nominal frequency.

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
death.

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
death.
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Basic Safety Instructions

Electrical safety

If the information on electrical safety is not observed either at all to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

2. Inthe case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with an earthing contact and protective earth connection.

3. Intentionally breaking the protective earth connection either in the feed line or in the product itself is
not permitted. Doing so can result in the danger of an electric shock from the product. If extension
cords or connector strips are implemented, they must be checked on a regular basis to ensure that
they are safe to use.

4. If the product does not have a power switch for disconnection from the AC supply network, the plug of
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the
power plug is easily reachable and accessible at all times (corresponding to the length of connecting
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from
the AC supply network. If products without power switches are integrated into racks or systems, a
disconnecting device must be provided at the system level.

5. Never use the product if the power cable is damaged. Check the power cable on a regular basis to
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully
laying the power cable, you can ensure that the cable will not be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.

6. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse
only after consulting with the Rohde & Schwarz group of companies).

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket. Otherwise, sparks that result in fire and/or injuries may occur.

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

9. For measurements in circuits with voltages V,s > 30 V, suitable measures (e.g. appropriate
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to
avoid any hazards.

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in

operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the

product.

12. If a product is to be permanently installed, the connection between the PE terminal on site and the
product's PE conductor must be made first before any other connection is made. The product may be
installed and connected only by a licensed electrician.

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective

devices, the supply circuit must be fused in such a way that anyone who has access to the product, as

well as the product itself, is adequately protected from injury or damage.
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14.

15.

16.

17.

18.

Basic Safety Instructions

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1. Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal", item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no
other settings or functions may be used as described in the product documentation. The objective is to
prevent personal injury (e.g. due to laser beams).
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Basic Safety Instructions

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation
resistance measurement, leakage current measurement, functional test). This helps ensure the
continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek
medical aid immediately.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

1171.0000.42-05.00 Page 5



Informaciones elementales de seguridad

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.

Waste disposal

1. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

Informaciones elementales de seguridad

Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
adjunto de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario
debera atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de
empresas Rohde & Schwarz esta siempre a su disposicion en caso de que tengan preguntas referentes a
estas informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Informaciones elementales de seguridad

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacién debida en la documentacién del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacioén del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccion de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios.

Simbolos y definiciones de seguridad

4 {5 _L

18 kg —

Aviso: punto de Atencioén en Peligro de Adver- Conexion a Conexion | Conexién Aviso: Cuidado
peligro general el manejo de | choque tencia: conductor de | atierra amasa en el manejo de

dispositivos eléctrico superficie proteccion dispositivos
Observar la » de peso caliente sensibles a la
documentacion elevado electrostatica
del producto (ESD)

| O 0 = ~ ~ O

Tension de Indicacion de Corriente Corriente alterna | Corriente El aparato esta protegido
alimentacion de estado de continua (DC) (AC) continua / en su totalidad por un
PUESTA EN espera Corriente alterna | aislamiento doble
MARCHA / (Standby) (DC/AC) (reforzado)

PARADA
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Informaciones elementales de seguridad

Palabras de seiial y su significado

En la documentacién del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

PELIGRO identifica un peligro inminente con riesgo elevado que
A PELIGRO provocara muerte o lesiones graves si no se evita.
ADVERTENCIA identifica un posible peligro con riesgo medio de
A ADVERTENCIA provocar muerte o lesiones (graves) si no se evita.

ATENCION identifica un peligro con riesgo reducido de provocar

A ATENCION lesiones leves o0 moderadas si no se evita.
AVISO indica la posibilidad de utilizar mal el producto y, como
m consecuencia, dafarlo.

En la documentacioén del producto se emplea de forma sinénima el
término CUIDADO.

Las palabras de sefal corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicion en otras areas econdémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacion del producto y
solamente en combinacién con el producto correspondiente. La utilizacién de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas Yy tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de sequridad del trabajo y de prevencién de accidentes.

1. Sino se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicidn de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccién IP 2X, grado de suciedad 2, categoria de sobrecarga eléctrica 2, uso
solamente en estancias interiores, utilizacién hasta 2000 m sobre el nivel del mar, transporte hasta
4500 m sobre el nivel del mar. Se aplicara una tolerancia de +10 % sobre el voltaje nominal y de
+5 % sobre la frecuencia nominal.

2. No situe el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacién del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacién de modo distinto al indicado en la documentacién del producto, pueden
causarse lesiones o incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.
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Informaciones elementales de seguridad

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

10.

1.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion moévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccion, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, se debera considerar
el enchufe del cable de conexién como interruptor. En estos casos se debera asegurar que el enchufe
siempre sea de facil acceso (de acuerdo con la longitud del cable de conexion, aproximadamente

2 m). Los interruptores de funcién o electrénicos no son aptos para el corte de la red eléctrica. Silos
productos sin interruptor estan integrados en bastidores o instalaciones, se debera colocar el
interruptor en el nivel de la instalacién.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacion adecuadas, de que el cable de conexion a red no pueda ser dafiado o de que nadie
pueda ser danado por él, p. ej. al tropezar o por un choque eléctrico.

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tension Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. €j. medios de medicién adecuados, seguros, limitacién
de tensién, corte protector, aislamiento etc.).

Para la conexion con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.
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12.

13.

14.

15.

16.

17.

18.

Informaciones elementales de seguridad

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles danos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacién contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacién de tension (p. €j. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.

Funcionamiento

1.

2.
3.

4.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos
(p. €j. el niquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones
alérgicas, como p. ej. irritaciones cutdneas, estornudos continuos, enrojecimiento de la conjuntiva o
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y
evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecanica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacién”, punto 1.
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5.

Informaciones elementales de seguridad

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcién natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefalizar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacion del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Reparacién y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensioén de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe seguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafo seco Yy limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Mantener baterias y celdas fuera del alcance de los nifios. En caso de ingestién de una celda o
bateria, avisar inmediatamente a un médico.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.
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Informaciones elementales de seguridad

6. En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la

piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacion las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacion utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafos.

Eliminacion

1.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formaciéon adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafnos a la salud o
dafios al medio ambiente.
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Qualitatszertifikat
Certificate of quality
Certificat de qualité

Sehr geehrter Kunde,

Sie haben sich fur den Kauf eines
Rohde & Schwarz-Produktes ent-
schieden. Hiermit erhalten Sie ein
nach modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Qualitatsmanage-
mentsystems entwickelt, gefertigt
und gepruft. Das Rohde & Schwarz-
Qualitdtsmanagementsystem ist u.a.
nach 1ISO9001 und ISO 14001
zertifiziert.

Der Umwvelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche Weiterentwicklung
nachhaltiger Umweltkonzepte

1 ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear Customer,

You have decided to buy a
Rohde & Schwarz product. You are
thus assured of receiving a product
that is manufactured using the most
modern methods available. This
product was developed, manufactured
and tested in compliance with our
quality management system stan-
dards. The Rohde & Schwarz quality
management system is certified
according to standards such as
ISO9001 and ISO 14001.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

1 1SO 14001-certified environmental
management system

Certified Quality System

IS0 9001

Certified Environmental System

1S0 14001

Cher client,

Vous avez choisi d'acheter un pro-
duit Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d'apreés les
méthodes les plus avancées. Le déve-
loppement, la fabrication et les tests
respectent nos normes de gestion
qualité. Le systéme de gestion qualité
de Rohde &Schwarz a été homologué,
entre autres, conformément aux nor-
mes ISO9001 et ISO 14001.

Engagement écologique

1 Produits a efficience énergétique

1 Amélioration continue de la durabilité
environnementale

1 Systeme de gestion de I'environne-
ment certifié selon ISO 14001
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

USA & Canada Monday to Friday  (except US public holidays)
8:00 AM - 8:00 PM  Eastern Standard Time (EST)

Tel. from USA 888-test-rsa (888-837-8772) (opt 2)
From outside USA  +1 410 910 7800 (opt 2)

Fax +1 410 910 7801

E-mail CustomerSupport@rohde-schwarz.com
East Asia Monday to Friday  (except Singaporean public holidays)

8:30 AM - 6:00 PM  Singapore Time (SGT)

Tel. +65 6 513 0488

Fax +65 6 846 1090

E-mail CustomerSupport@rohde-schwarz.com
Rest of the World Monday to Friday  (except German public holidays)

08:00 - 17:00 Central European Time (CET)

Tel. +49 89 4129 13774

Fax +49 (0) 89 41 29637 78

E-mail CustomerSupport@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-04.00
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Address List

Headquarters, Plants and Subsidiaries

Headquarters

ROHDE& SCHWARZ GmbH & Co. KG
Miihldorfstrafe 15 - D-81671 Minchen
P.0.Box 80 14 69 - D-81614 Miinchen

Plants

ROHDE& SCHWARZ Messgeratebau GmbH
RiedbachstraRe 58 - D-87700 Memmingen
P.0.Box 16 52 - D-87686 Memmingen

ROHDE& SCHWARZ GmbH & Co. KG

Werk Teisnach

Kaikenrieder Strae 27 - D-94244 Teisnach
P.0.Box 11 49 - D-94240 Teisnach

ROHDE&SCHWARZ zavod
Vimperk, s.r.o.

Location Spidrova 49
(CZ-38501 Vimperk

ROHDE&SCHWARZ GmbH & Co. KG
Dienstleistungszentrum Kéln
Graf-Zeppelin-StraBe 18 - D-51147 KdlIn
P.0.Box 98 02 60 - D-51130 KéIn

Subsidiaries

R&S BICK Mabilfunk GmbH
Fritz-Hahne-Str. 7 - D-31848 Bad Minder
P.0.Box 20 02 - D-31844 Bad Miinder

ROHDE& SCHWARZ FTK GmbH
WendenschloRstraRe 168, Haus 28
D-12557 Berlin

ROHDE& SCHWARZ SIT GmbH
Am Studio 3
D-12489 Berlin

R&S Systems GmbH
Graf-Zeppelin-StraRe 18
D-51147 KéIn

GEDIS GmbH
Sophienblatt 100
D-24114 Kiel

HAMEG Instruments GmbH

Industriestrale 6
D-63533 Mainhausen
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Phane +49 (89) 41 29-0
Fax +49 (89) 41 29-121 64
info.rs@rohde-schwarz.com

Phone +49 (83 31) 1 08-0
+49(8331) 108-1124
info.rsmb@rohde-schwarz.com

Phone +49 (99 23) 8 50-0
Fax +49 (99 23) 8 50-174
info.rsdts@rohde-schwarz.com

Phone +420 (388) 45 21 09
Fax +420 (388) 45 21 13

Phane +49 (22 03) 49-0

Fax +49 (22 03) 49 51-229
info.rsdc@rohde-schwarz.com
service.rsdc@rohde-schwarz.com

Phone +49 (50 42) 9 98-0
Fax +49 (50 42) 9 98-105
info.bick@rohde-schwarz.com

Phone +49 (30) 658 91-122
Fax +49 (30) 655 50-221
info.ftk@rohde-schwarz.com

Phone +49 (30) 658 84-0
Fax +49 (30) 658 84-183
info.sit@rohde-schwarz.com

Phone +49 (22 03) 49-5 23 25
Fax +49 (22 03) 49-5 23 36
info.rssys@rohde-schwarz.com

Phone +49 (431) 600 51-0
Fax +49 (431) 600 51-11
sales@gedis-online.de

Phone +49 (61 82) 800-0
Fax +49 (61 82) 800-100
info@hameg.de

Locations Worldwide

Please refer to our homepage: www.rohde-schwarz.com

@ Sales Locations
@ Service Locations
@ National Websites



1 Overview
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Acoustic Measurements on Mobile Phones

The acoustic transmission and reproduction quality of a mobile phone is its
most important characteristic in everyday use. Even the most visually
appealing design and wonderfully sophisticated operating concept are not
much use, when the user cannot or can hardly understand what is being said
at the other end.

Instruments and methods for measuring acoustic characteristics are therefore
essential tools for assessing the quality and suitability of a mobile phone.

Since a digital audio interface is no longer required even for conformance tests on
3rd generation mobile phones, it was necessary to develop new test methods that
allowed measurements to be performed via the air interface and the normal
speech coder and decoder. The test signals have to simulate human voice in the
frequency and time domain to be able to test the mobile phone in the normal
operating mode with DSP assessment such as voice activity detector (VAD),
noise suppression, echo cancellation, etc switched on.

These tests are based on standards for 3GPP mobile phones. The test methods
are stipulated in 3GPP TS 26.132 and the values to be attained in 3GPP
TS 26.131.

As of release 4 of the GSM 51.010 standard (successor to GSM 11.10), even
GSM mobile phones may be tested to 3GPP TS 26.132.

The R&S UPV-K9 and R&S UPV-K91 options (UMTS/GSM Mobile Phone Tests)
of the Audio Analyzer R&S UPV, called herein below “UPV”, are now available for
measuring the acoustic characteristics of UMTS and GSM mobile phones. The
measurements are in line with 3GPP TS 26.131, TS 26.132 and TS 51.010 and
have been validated by an independent test house for conformance testing on
UMTS and GSM mobile phones.



Acoustic Measurements on Mobile Phones

2 Preparation and Start of the Application Software

1402.0043.12

Required Measuring Instruments and Accessories

The Audio Analyzer R&S UPV with the following options is required for the
measurements:

e Base Software for Mobile Phone Tests R&S UPV-K9
e UMTS/GSM Mobile Phone Tests R&S UPV-K91
Note: The UPV firmware version must be 2.4.0.452 or higher.

The GSM mobile phone under test is connected via the RF interface using
the Universal Digital Radio Communication Tester R&S CMU200, called
herein below CMU 200. This tester simulates a base station for the mobile
phone so that a call can be set up. For GSM, the CMU200 must be
equipped with the options CMU-B21 (signalling unit), CMU-B52 (speech
coder/decoder) and the appropriate software options for the GSM band
used. For WCDMA (UMTS), the option CMU-B69 is required. Wideband-
AMR tests require option CMU-K46 for both GSM and/or WCDMA (UMTS).

Note: The firmware level in the CMUZ200 must be 4.52 or higher.

Acoustic devices such as an artificial mouth, artificial ear and other
accessories are required for the measurements. The following equipment
from Briel & Kjaer or G.R.A.S. is normally used:

Table 1 Equipment for mobile phone tests

Device

Description

Type (examples)

Telephone test head

Device for fixing the DUT in the
prescribed position

B&K 4602B

Wideband ear simulator

IEC 711 type occluded ear simulator
with adapters for connection to the
ear piece of the DUT

B&K 4195 (type 3.2)

Artificial mouth

Special loudspeaker for simulation
of the mouth

B&K 4227 or
G.R.A.S. 44AB or
44AA (with power

amplifier)
Head and torso simulator Head and torso simulator with B&K 4128 D
artificial ear (type 3.3) and artificial
mouth, may be used alternatively to
the abovementioned devices
Handset fixture for Head Required to position the handset on B&K 4606

and Torso simulator

the artificial head, and to apply a
defined force with the earpiece
against the pinna

Measurement microphone

2" or ¥4 measurement microphone
for measurement of artificial mouth
output during calibration. This
microphone can use the preamplifier
of the artificial ear.

B&K4191 (free field,
may be used for
hands free tests),
B&K 4192 (pressure
field, may be used
with type 1 art. ear)

Acoustic calibrator

Sound level calibrator for calibrating
the measuring microphone

B&K 4231

Microphone power supply

Power supply and preamplifier for
the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA

E-4
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Acoustic Measurements on Mobile Phones

Note: With the amplifier set to 0 dB, the microphone power supply B&K
2690A0S2 produces too much noise for measuring idle noise and
distortion. It is therefore advisable to set a gain of 20 dB.

A cable with a BNC connector and special small or angled banana plugs is
required for connecting the artificial mouth, as the space between the
mouth connectors and the LRGP test head (B&K 4602B) is too small for
common banana plugs.

The transformer supplied with option R&S UPV-K9 must be connected
between generator output 1 of Audio Analyzer R&S UPV and the connector
of the artificial mouth. The transformer matches the impedance of the
loudspeaker in the artificial mouth to that of the generator output of the
R&S UPV. Without this transformer, the available power is too low for
driving the artificial mouth.

Alternatively, a power amplifier, preferably with a voltage gain of approx.
0 dB, can be connected between generator output and mouth instead of the
transformer. In this case, the gain set must be kept absolutely stable after
calibration.

A cable with male (analyzer) and female (generator) XLR connector is
supplied for connection to the "Speech" connector of the Digital Radio
Communication Tester CMU.

UPV Analyzer Generator

Fig. 1 Assignment of 9-contact speech connector on CMU front panel

This cable is configured for connection to link handler #1 in the CMU.
Depending on the CMU hardware, link handler #2 in the CMU can also be
used for GSM; in this case, the supplied adapter must be inserted between
the cable and the speech connector on the CMU.

Note: If the CODEC calibration fails, the adapter has most likely to be
inserted.
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Note: The CMU connects pin 1 of the R&S UPV generator output to
the equipment grounding conductor of the mains. If an external
power amplifier is used, care must be taken that the external
power amplifier does not connect R&S UPV generator output pin
2 to the equipment grounding conductor of the mains. If
available, a balanced connection to the power amplifier should
be preferred.

Attention: An external power amplifier should be switched on after the
R&S UPV-K9x program has been started, and switched off
before the program is ended. This prevents the artificial mouth
from undue power loading by setups which are loaded external
to the application.

Note: An external USB keyboard and a mouse must be connected to
the R&S UPV.

Caution: R&S UPV-K9x does not support the use of headphones. Do not
connect headphones to the R&S UPV during mobile phone
tests. High level signals may be present at the headphone
connector.

The program required and the associated files are in the folder “UPV-K9x
Software” on the installation CD supplied with the R&S UPV-K91 option.
The audio analyzer must meet the following firmware requirements:

e R&S UPV firmware version 2.4.0.452 or higher
e Option R&S UPV-K9 installed
e Option R&S UPV-K91 installed.

Installing the Software

The application program requires option keys K9 and K91 to be installed.
The keys are installed in the factory in case a new R&S UPV is ordered
together with these options. If the options are ordered separately, the keys
as well as the installation manual are part of the delivery.

It is recommended to copy the files UPV-K9x.msi, Config.ini, dotnetfx.exe,
Setup.exe and Settings.ini from the folder “UPV-K9x Software” on the
installation CD to drive D: on the R&S UPV hard disk drive, e.g. to a folder
named “D:\R&S Software\UPV-K9x\Version x.y”. Run the file “Setup.exe” to
start the installation. Follow the instructions of the installer on the screen.

To have full control over minimized windows, it is recommended to set the
windows taskbar to “Auto-hide”, on top of other windows. Right-click on the
Windows Start button and click “properties”.

Open
Explore

Search. ..

Properties

Cpen All Users
Explore All Users

It.‘Sl:a'l'tH = o390

Fig.2  Context menu for taskbar
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In the properties window, click tab “Taskbar” and activate “Auto-hide the
taskbar” and “Keep the taskbar on top of other windows”. Click “Apply” and
close the window.

Taskbar and Start Menu Properties |

Taskbar I Start ke I

— Taskbar appearance

[ Laock the taskbar
¥ &uto-hide the taskbar
¥ Keep the taskbar on top of other windows

¥ Group similar tagkbar buttans
¥ Show Quick Launch

— Matification area

(¢ )llne 1:23 PM

¥ Show the clock

Y'ou can keep the notification area uncluttered by hiding icons that wau
hawve not clicked recently.

¥ Hide inactive icons Customize... |
k. I Cancel | Apply |

Fig. 3 Properties window for taskbar

Test Setup
1 Microphone
; Supply
O O P
art ear
l
Transformer DQ
rorstm}—
art mouth

]
0
]
]
]
]
]
]
0

‘B:IIIIIIIII

RF to Mobile

Fig.4  Test setup and connection of external components
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3GPP TS 26.132 specifies binaural measurement for the test of Handsfree
(speakerphone) devices using a head-and torso simulator (HATS). From
Release 8, binaural measurement is also foreseen for binaural headsets.
The HATS 4128 supplied by Bruel & Kjaer offers an optional left ear
simulator 4159C for binaural measurements. The second ear simulator has
to be connected to UPV analyzer input 2 for binaural receiving
measurements. As this input is also used to connect to the CMU decoder
output for sending measurements, R&S 3GPP Mobile Phone Tests UPV-
K91 support automatic control of an input switcher UPZ. The connection for
automatic input switching is done as shown in Fig. 5.

Power Supply

Power Supply

Amplifier or -

Transformer

v;,‘r

L H‘
XS Em:ma

@@

RF Connection ” ‘

Fig. 5 Test setup and connection of external components for automatic
swiching

Starting the Application Software

After installation, the program can be started by double-clicking the Icon
“UPV-K9x Mobile Phone Tests” or by clicking “R&S UPV Applications »>
UPV-K9x Mobile Phone Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the artificial
ear and artificial mouth used.

@ Standard M =]

Fleaze select a standard below:

AGPF HandS M arrow

[ Allow only selected measurements

Cancel | k. I
/'

o

Fig. 6  Query window for selection of applied standard
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If “none” is selected in the standard selection window, all measurements
appear in the “Measurement” menu. If a standard is selected, all
measurements appear in the “Measurement” menu, but compliant
measurements are checked in the menu. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu. “Non-standard handset” and “non-standard
hands free” select handset or hands-free tests, respectively, which can be
customized.

Select Ear Simulator

Type 1

Type 3.2 Low Leak

Type 3.2 High Leak

Type 3.3

Type 2.4

Electnz connection

| nduction coil

[T Do not show this dislog again

Cancel | k. I
y

Fig. 7  Query window for selection of artificial ear

®5elect mouth type  [H[=]

LRGP ITU-T P.51

HATS ITU-T P.58

Genenc speaker

Electnz connection

[T Do not show this dislog again

Cancel | k. /L
2

Fig. 8  Query window for selection of artificial mouth

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
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below). After the last of the three selection windows has been closed, the
main window of the R&S UPV-K9 opens.

®UPV-K9H Mobile Phone Tests (D:\3GPPResults.xml) =] |

File Data Calibration Measurement Standards Corfig, Meas. Seguence Report  Options  Help

Testresults overdiew

Select Date and time | Measurement title | Test object | Werdi | Camment 1=
N — 04/14/200315:17:21 3GPP Digtortion Sending ‘wide, Rel. 8 Sample Test Dbject FAIL
I — 04/14/2009 15:15:56 3GFP Distortion Sending Wide. Rel. 8 Sample Test Object FalL
[ 04/14/2009 15:25:05 3GFP Distortion Sending Wide. Rel. 8 Sample Test Object Pass
T 04/14/2003 15:27:27 3GPP Distortion Aeceiving Wide, Rel 8 Sample Test Dbject FaIL
I — 04/14/2009 15:34:30 3GPP Sending Handset Manowband Test Mobile FalL
I — 04/14/2009 15:34.51 3GPP Receiving Handset, nom. Val, Rel 8§ Manowband Test Mobile FAIL
I 04/14/2009 15:35:12 3GFP Ide channel noize sending Marowband Test Mobile PASS
I — 04/14/2003 15:35:23 3GPP Ide channel noise receiving, nom. vol. Marowband Test Mobile PASS
. - 0471442003 15:35:34 3GPP Distortion sending Rel. & Manowband Test Mobile FASS
I 04/14/2003 15:36:33 JGPF Distartion receiving Manowband Test Maobile FAIL
. - 04/14/2009 15:38:11 3GPP STMR, HATS Method, Nom. Yl Marnowband Test Mobile Fall
I — 04/14/2009 15:38.37 3GPP Receiving Handset, max. ol Manowband Test Mobile PASS
I 04/14/2009 15:38:54 3GPF Idle channel noise receiving, max. vol Manowband Test Mobile PASS
N (04/14/2009 15:33:06 3GPP STMR, HATS Method, All'ol. Steps Marmowband Test Mobile PASS
I 04/14/2009 15:35:26 3GFP Receiving Handset, min. Vol Marowband Test Mobile PASS
- (04/14/2009 15:33:44 3GPP STMR, HATS Method, Aol Steps Marrowband Test Mobile PASS
. - 04/14/2003 15:42:14 3GPP Sending Handset wWide. Rel 8 ‘wideband Test Mobile FAIL
(] 0441442009 15:42:35 3GPP Receiving Handset, nom. Vol Wide, Rel  ‘wideband Test Mobile Fall
I 04/14/2009 15:42.57 3GFF |dle Channel Moise Sending, 'Wideband  ‘wideband Test Mobile PASS
I — 04/14/2009 15:43:09 3GPP Ide Chanrel Moise Rec., nom. %ol Rel  |‘wideband Test Mobile PASS
I 04/14/2009 15:43:22 3GFP Distortion Sending ‘ide, Rel. & ‘wideband Test Mobile FaIL
N — 04/14/2009 15:45:03 3GFP Distortion Receiving Wide, Rel 8 ‘wideband Test Mobile FalL
1 (04/14/2009 15:47:32 3GPP STMR. HATS, Nom. Vol Wideband ‘Wideband Test Mabile FAIL
(] 04/14/2003 15:47:53 JGPP Sidetone Delay ‘wideband Test Mobile PASS o
. - 0441442009 15:48:26 3GPP Receiving Handset, max. Yol Wide, Rel  ‘Wideband Test Mobile PASS
I — 04/14/2009 15:48:47 3GPP Idle Channel Moise Rec., max. Yol., Rel  |‘wideband Test Mobile PASS =
[4.H 49003 14001 AROD CTHAD LATE Alfal Chama bifideband tfidabond T oot hdekile oacc
4] | LI_
3PP Hands wide, Rel8 |HATS Type 33Am Ear  |CMU / CBT | wideband Test Mokile
Report last | | Report last | Exit |
Mmeasulement seguence

Fig. 9 Main window

Initially the data grid in the center of the screen which shows the result
overview is empty. The screenshot in Fig. 9 shows an example after a
number of measurements have been made.

By clicking with the right mouse button on the data grid, a context menu
opens which allows to create a report of a result marked by a solid triangle
in the respective row header, delete the marked result or to export one of
the curves in the marked result graph to an ASCII format.

Create Report For Marked Row
Delete Marked Row
Save Curve of Marked Row as ..,

Repart Sele Repork Selected Resulks
Sort Chronologically Select all
Deselect all

Delete Selecked Resulks

Fig. 10  Context menu of the result data grid

Fig. 11 A triangle in the row header indicates a marked row

The “Report Selection” submenu allows to report on or delete a selection of
results which have been marked in the “Select” column of the data grid. To
select or unselect a result, click in the “Select” column of the respective
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row. Selected rows show “XXXXX”, unselected rows show “------- in this
cell.

If the results have been sorted alphabetically according to one of the
columns by clicking on the respective column header, the chronological
order can be restored using the context menu item “Sort Chronologically”.

Operating Concept

R&S 3GPP mobile phone tests consist of the main user interface window
which allows general settings, calibration routines, data handling, automatic
sequencing and reporting tools, and of test macros for basic measurement
types defined in the standards. Each measurement type provides a set of
parameters (R&S UPV setup files, limits etc.) which are defined in
separated measurement definition files, one for each test case.

Options (General settings)

EE
Options  Help
Standard
Select standard at startup
Ear Simulator
Select ear simulator at startup
Artificial mouth
Select artificial mouth at startup
System simulakor
Hands Free settings
v Show operator instruckions
Input switcher
Report setkings
Generate temporary export files
Store resulks of further measurements
v Do nok change scale for fFurther meas,
Store loaded curve data to results

Fig. 12  Options menu

The “Options” menu in the main window allows to change a set of general
settings like ear type and mouth type used which are valid for all or at least
a plurality of the tests.

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For details
on the handling of calibration data see section 4 “Calibration” below.

If “Select ear simulator at startup” is checked, the selection window for
the ear simulator is opened at each start of the program.
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“Artificial mouth” allows to select the type of artificial mouth used. For
details on the handling of calibration data see section 4 “Calibration” below.

If “Select artificial mouth at startup” is checked, the selection window for
the artificial mouth is opened at each start of the program.

“System simulator” allows to select the type of system simulator used.
For details on the handling of calibration data see section 4 “Calibration”
below.

“Hands free settings” allows to select the acoustic instruments used for
hands free testing. It is possible to use an ITU-T P.51 artificial mouth
together with a free field microphone, a HATS with one artificial ear or a
HATS with two artificial ears. If two artificial ears are used, the decoder has
to be disconnected from analyzer input 2 and the second artificial ear has to
be connected to it for receiving measurements. Do not forget to re-connect
the decoder for any measurement in sending direction.

If “Show operator instructions” is checked, instructions to the operator
are displayed in a window before the measurement starts. The operator
may be prompted to position the mobile in a defined way or to set the
volume to a certain setting.

“Input Switcher’ allows to configure the use of a UPZ input switcher
connected to the UPV RS-232 port, to switch analyzer input 2 between
sending tests and binaural receiving tests.

Switcher Settings

r Uze UFZ input zwitcher to connect second artificial
ear for binaural measurements and calibration

UFZ output connected bo analyzer input 2

Cluatpuat A COutput B

Decoder output connected to LIFE input no. I ‘IE:

2nd artificial ear connected to UFZ input no. I 25:

Cancel | k. I
/'

o

Fig. 13  Switcher window

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.

If “Generate temporary export files” is checked, some of the
measurement macros create “result.exp” with result value and verdict, and,
if applicable, “curve.exp” or “abscurve.exp” and “relcurve.exp” files with
curve data in ASCII format. This function is provided for compatibility with
UPL-B9, and is not supported by all measurement types.

If “Store results of further measurements” is checked, curves and
calculated values like loudness ratings are also stored for additional
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measurements started with the “Add Measurement” key. They will appear in
reports of the respective measurements.

Menu item “Do not change scale for further meas.” deactivates the
automatic Y-axis scaling if the curve of an additional measurement leaves
the plot area partially or totally.

If “Store loaded curve data to results” is checked, curves loaded from file
with the “Load Curve” softkey are stored to the results database and will
appear in reports of the respective measurements.

Attention: Do not attempt to modify files with extensions “set”, “sup”, “xml’,
“cal” “seq” or “mdf’, using a text editor. Any change with a text
editor may make the files unusable and cause malfunction of the
Software.
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Calibration Devices

R&S UPV-K9 allows to simultaneously store calibration values for multiple
individuals of the same type. This allows to switch devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

Mobile Phone Tests (D2 3GPPY,

Calibration  Measurement  Standar

| v Selective
Microphone
Arkificial Ear

DRP ko ERP correckion

Free field equalization
Artificial Mouth

Arkificial Mouth (Hands Free)
Codec

Induction coil

v T v v v v

Electric connections g
Ambient noise Field

Mew Dievice

Select Device

Show all »alues

Show selected devices

Fig. 14 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button. If the box “Immediately select this device” is
checked, the device is selected for immediate use with the “Save, select
and close” button.

For ease of use, a “default” device is present and selected for each device
type (category) upon first start of the program.
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Calibrated Deyice

Uzage

| =l
Type

b arufacturer

Senal Hurmber

[T Immediately select this device

Cancel | | Save and cloze

)

Fig. 15 Input window for information about calibrated device

Before a device can be calibrated or used, it must be selected. This can be
done from the “Calibrated Device” input window if the checkbox
“Immediately select this device” is checked. Existing devices may be
selected with “Calibration - Select device” in the main menu. Clicking on
this item opens a window with a table of all entered devices.

Select Calibrated Devices

¢ | Manufacturer | Type | SerialNa. | Dats and Time | Calib. value | File name |
4 & Default 08/25/2007 17:21 [rull] D:NIGPPYCa
Decoder Default 0741342006 17.50 [rwall) [D:M3GPPYCa
Diffuse field microphone Default 07/13/2006 17.57 [rwall) [:MN3GPPYCa
Electric connection replacing decoder Default 07/13/2006 17.54 [rull) D:M3GPPYCa
Electric connection replacing ear Default 1041142007 11:36 [rwall) D:M3GPPYCa
Electiic connection replacing encoder Default 07/13/2006 17.54 [rull] [ \3GPPACa
Electric connection replacing mouth Default 07413/2006 17:51 [rwall) [:MN3GPPYCa
Encoder Default 07413/2006 17.51 [rull) D:M3GPPYCa
Free field microphone Default 0B/07/2006 15:50 [rwall) D:M3GPPYCa
Genernic speaker Default 07/13/2006 16:33 [rull] [ \3GPPACa
HATS ITU-T P.58 At Mouth Default 0B/07/2006 15:47 [ruall] D:3GPPYCa
HATS Type 33Am Ear Default 0B/07/2006 15:52 [ruall] D:\3GPPYCa
HATS Type 3.4 Art. Ear Default 06/07/2006 15:54 [rull] D\ 3GPPACa
Induction coil [input] Default 07/13/2006 18:04 [rull] [ \3GPPACa
Input digital Default 0B/07/2006 15:43 [ruall] D:3GPPYCa
LRGP ITU-T P.51 At Mouth Default 07/13/2006 17:69 [ruall] D:\3GPPYCa
Output digital Default 0B/07/2006 15:50 [rwall) D:M3GPPYCa

Second Type 3.3 At Ear Default 07/11./2007 15:09 [rull] D:A3GPPYCa |
Second Type 3.4 At Ear Default 07411/2007 15:09 [rwall) [:MN3GPPYCa
Type 1 A Ear Default 06407 /2006 15:51 [rull) D:M3GPPYCa

7l Tupe 3.2 Hioh Leak ArtEar D efault OB/07 /2006 15:51 Tl | D436 PP\EJLI

IEeIecl uzage type first! j Sl | Cancel | Ok I

Fig. 16 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with a mouse click on its left end. A mouse click on the button “Select’
selects this device for the associated usage.
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Select Calibrated Devices

Usage | b anufacturer | Tppe | Serial Mo. | [Diate and Time | Calib. walue ‘ File name

Type 3.2 Low Leak ArtEar BEK 4195 1708754 04/22/2009 14:25 [ruall] D:A3IGPPYCal33:
Type 3.2 Low Leak Art.Ear Default 07/13/2006 17.57 [rull) D:A3GPPLCal33l
Type 3.2 Low Leak At Ear G.R.AS RAO0SE & R | 26740 &% 4638 | 04,/22/2009 14:27 [rll] D:\3GPP.Cal33l

ITyDe 3.2 low leak art. ear j Select | Cancel | Ok I

Fig. 17 Selection window for particular device type

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K91 option are stored independently of other options.
Calibration values for 3GPP tests and CDMA2000 tests are handled
separately.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.

To simplify the procedure for the case that it is not intended to use multiple
devices of the same category nor to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

An overview of all selected calibration devices together with the calibration
values is given under the menu item “Calibration - Show selected
devices”.
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Microphone Calibration

> Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator. A %" adapter or V"
adapter is required according to the microphone diameter.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

> Call the test routine with “Calibration = Microphone = Free field” or
“Calibration > Microphone - Diffuse field” from the main menu,
depending on the microphone.

Microphone calibration

Connect microphone 1o analyzer input 1.
Insert ricrophone into calibrator using
adapter UC0210 and switch on calibrator.

[T Calibration level increased by 20 dB [not wvalidated)

[ Delay start by I I:IE: zeconds

Cancel | )3

Fig. 18 Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked! If a calibrator with a
frequency other than 1000 Hz is used, make sure that the “Selective” item
in the Calibration menu is unchecked.

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in the
calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa) . If a
conditioning amplifier with 20 dB gain (recommended value) is used, the
displayed sensitivity must be about 10 times higher (e.g. 120 mV/Pa). If the
voltage measured is below 3 mV, an error message is displayed. Possible
error sources are, for example, a switched-off microphone power supply or
a disabled calibrator. In this case, the program requests that the test be
repeated. After switching on the microphone power supply, wait approx.
20 s before starting the calibration again.

19 E-4



Acoustic Measurements on Mobile Phones

Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in the
artificial ear must be determined using a sound level calibrator such as the
Briel & Kjeer 4231 with a sound pressure level of 94 dBSPL or a sound
pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1
> Switch off the microphone power supply.

Attention: The 200 V polarization voltage of the microphone may cause
a slight electric shock. The current is harmless, but the
microphone preamplifier may be damaged.

» Remove the microphone from the artificial ear.

> Screw back the microphone capsule and switch on the operating
voltage.

> Insert the microphone fully into the adapter of the sound level
calibrator and switch on the calibrator.

Note: After inserting the microphone wait about 10 s to allow for
static pressure compensation.

> Select “Calibration - Artificial ear > Type 1” from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity
displayed with reference to 1 Pa. If a mere power supply without gain is
used, the displayed sensitivity must approximately match the value in
the calibration certificate of the microphone capsule (typical value for
microphone capsule 4134 of artificial ear 4185 is approx. 12 mV/Pa) . If
a conditioning amplifier with 20 dB gain (recommended value) is used,
the displayed sensitivity must be about 10 times higher (e.g.
120 mV/Pa). If the voltage measured is below 3 mV or fluctuating by
more than 0.2 dB, an error message is displayed. Possible error sources
are, for example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the test be repeated.
After switching on the microphone power supply, wait approx. 20 s
before restarting the calibration.

The reference value measured is stored in a file on the hard disk and
used for all subsequent measurements when the same artificial ear type
1 is used as currently selected.

Calibration of Ear Type 3.2 Low Leakage

> Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

> Select “Calibration = Artificial ear - Type 3.2 Low Leak” from the
main menu.
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For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2L is
used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of Type
3.2L:

The frequency response of the artificial ear of type 3.2L is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_LL.ADA” from the manufacturer’s calibration disk to a

USB stick or a CD-ROM or make this file available on a network drive via

LAN.

Call the routine “Calibration - DRP to ERP Correction = Type 3.2 Low
leak”. Browse to the file “OES_LL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.2 High Leakage

>

>

Connect the sound level calibrator tightly to the artificial ear using the
adapter DP0939 and switch on the calibrator.

Select “Calibration > Artificial ear > Type 3.2 High Leak” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
measurement.
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The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.2H is
used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of Type
3.2H:

The frequency response of the artificial ear of type 3.2H is supplied on a
floppy together with the artificial ear. The data is used for transforming
the measurement values from the drum reference point to the ear
reference point.

Connect a USB floppy disk drive with the calibration disk to the R&S UPV,
copy the file “OES_HL.ADA” from the manufacturer’s calibration disk to a
USB stick or a CD-ROM or make this file available on a network drive via
LAN.

Call the routine “Calibration - DRP to ERP Correction = Type 3.2 High
leak”. Browse to the file “OES_HL.ADA” and click “Open”.

The calibration file is read. The modified data is stored on the R&S UPV
hard disk. This procedure needs only be repeated after a change of the
calibration data, e.g. after a recalibration of the ear by the manufacturer,
or when the “3GPP” directory has been renamed or removed.

Calibration of Ear Type 3.3

>

>

>

Remove the pinna from the artificial ear according to the
manufacturer’s instructions

Connect the sound level calibrator tightly to the artificial ear using the
adapter UA-1546 and switch the calibrator on.

Select “Calibration > Artificial ear > HATS Type 3.3” from the
main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the
checkbox “Calibration level increased by 20 dB” must be checked. In all
other cases the checkbox must remain unchecked!

The type 3.3 ear calibration requires the calibrator with adapter UA-1546
to be held manually against the ear. If the HATS is installed remote from
the UPV, the checkbox “Delay start by ... seconds” can be checked and
a time interval can be entered by which the start of the calibration
measurement is delayed. The countdown is displayed on the UPV
screen.
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Microphone calibration

Connect artificial ear to analyzer input 1.
Put art. ear on calibrator with adapter part
LA1546 and switch on calibrator.

[T Calibration level increased by 20 dB [not validated)

[V Delay start by I 53: zeconds

Cancel | ] 3

Fig. 19 Ear calibration window with delayed start

The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.3 is
used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of Type 3.3:

Call the routine “Calibration > DRP to ERP Correction > Type 3.3
—>From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “3GPP” directory has been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction
data from a calibration disk. This option is not conformant with the
standards.

Calibration of Ear Type 3.4

> Remove the pinna and the ear canal simulator, connect the sound

level calibrator tightly to the artificial ear using the short steel adapter
and switch the calibrator on.

Select “Calibration - Artificial ear > HATS Type 3.4” from the
main menu.

For Head Acoustics HMS II, calibrator B&K 4231 must be used in
conjunction with the short steel calibration adapter.
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The output voltage of the microphone in the ear is measured and the
sensitivity displayed with reference to 1 Pa. If the voltage measured is
below 3 mV or fluctuating by more than 0.2 dB, an error message is
displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the
program requests that the test be repeated. After switching on the
microphone power supply, wait approx. 20 s before restarting the
calibration.

The measured reference value is stored in a file on the hard disk and
used for all subsequent measurements when the same ear type 3.4 is
used as currently selected.

Reading the DRP-ERP Correction Data of the Artificial Ear of Type
3.4:

Call the routine “Calibration > DRP to ERP Correction - Type 3.4
- From ITU-T P.57 Table 2b”. This procedure needs only be repeated
when the “3GPP” directory has been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction
data from a calibration disk. This option is not conformant with the
standards.

Calibration of Artificial Mouth for Handset Tests

Before a mobile phone can be tested, the absolute sensitivity and frequency
response of the artificial mouth have to be measured and corrected with the
aid of a previously calibrated free-field or diffuse-field (pressure-field)
microphone. The measuring microphone removed from artificial ear type 1
can be used for this purpose or an additional microphone capsule is
screwed to the microphone preamplifier. The standard microphone is used
as a reference for determining the frequency response of the mouth. The
frequency response of the microphone can be ignored in the test frequency
range (100 Hz to 8 kHz) (see also calibration certificate of microphone
capsule).

Since interfering sound falsifies the corrections, the artificial mouth must be
calibrated in the anechoic and isolated test chamber. In order to reject any
noise present in the test chamber, it is recommended to activate item
“Selective” in the calibration menu.

First of all, a calibrated measuring microphone has to be selected.

> Select a reference microphone type with “Calibration = Artificial
mouth > Select reference mic”.

For the selected microphone type, a device must be selected and
calibrated (see above). This device must be connected to R&S UPV
analyzer input 1 via power supply/conditioning amplifier.

For calibration of a P.51 type artificial mouth using a diffuse field type
microphone (e.g. B&K 4131 or 4134) or a microphone from a Type1
artificial ear, fit the microphone at right angles to the mouth at the mouth
reference point (MRP) using the gauge supplied with the mouth
(positioning at right angles is necessary because diffuse field or
pressure-calibrated microphones have a flat frequency response to
sound from random incident direction and therefore exhibit an emphasis
on high frequencies with frontal sound incidence).
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For calibration of a P.51 type artificial mouth using a free field
microphone, the microphone must be mounted in the axis of the sound
outlet of the artificial mouth.

For calibration of the HATS (P.58 type) artificial mouth, a ¥2” microphone
is clamped in the fixture attached to the HATS.

> Call the calibration routine with “Calibration = Artificial mouth >
LRGP ITU-T P.51” or “Calibration = Artificial mouth = HATS ITU-T
P.58” from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in an
automatic measurement routine at 1 kHz. The generator voltage required is
stored in a file on the hard disk and used as a reference for all subsequent
settings with the same artificial mouth. If the sound pressure cannot be
adjusted to -4.7 dBPa, an error message is displayed with a request to
check the connection of the artificial mouth and to repeat the measurement.
A possible error source would be that the transformer supplied is not
connected between the generator and the artificial mouth.

The uncorrected frequency response of the artificial mouth is measured
and displayed. Next, the frequency response is measured with the
inverse frequency response correction automatically selected in the
generator (equalization). Residual errors caused by nonlinearities of the
speaker in the mouth are measured and taken into account in the final
equalization file as fine correction.

To verify the results, the absolute sound pressure versus frequency is
measured at a sound pressure of 4.7 dBPa (reference value for most of
the measurements). The absolute sound pressure at each frequency
must be within a tolerance band of +0.2 dB. Correct calibration without
interfering sound yields an almost straight line in the middle between the
two limit lines.

Calibration of CMU Speech Coder

The calibration of the speech coder and decoder is necessary to be able to
calculate absolute loudness. Calibration has to be performed only once and
must be repeated only if the CMU used is replaced. If the CMU is equipped
with model 14 of the Link Handler CMU-B21, GSM as well as WCDMA use
the same paths. Calibration of the coder is therefore identical for both
operating modes and need not be repeated when switching from GSM to
WCDMA or vice versa.

If GSM and WCDMA use different link handlers, separate calibration
devices have to be generated for the two link handlers (i.e. with and without
the supplied adapter).

Note that encoder and decoder are handled as separate devices but
calibrated with one routine.

Auxiliary settings required for calibration can be found in the CMU under Bit
Stream (for GSM) and under BS Signal, Dedicated Channel, Voice settings
(for WCDMA) (firmware version 4.52 or higher). Call the calibration routines
with “Calibration - Codec” from the main menu.
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The following information is displayed:

Eskablish call and set 'Bit Stream’ to 'DecoderCal'l

Fig. 20 Message box during decoder calibration

Set up a call to the mobile phone. Set bit stream or voice setting on the
CMU to "Decoder Cal" and then click the “OK” button.

The actual voltage at the decoder output of the CMU is now measured for a
digital full-scale signal and the required correction value is calculated and
saved in the R&S UPV. The following request is then displayed:

Set 'Bit Stream’ ko ‘EncoderCal'l

Fig. 21 Message box during encoder calibration

After the “OK” button has been clicked, the input sensitivity of the speech
coder is measured and the input voltage required for digital full scale is
measured at the speech coder and saved in the R&S UPV.

Calibration of Ambient Noise Field

For the calibration of the noise field for ambient noise rejection tests, all
obstacles (test head or HATS, Telephone etc.) have to be removed from
the test chamber. For the generation of the noise field, additional equipment
is necessary. The noise field should have sufficient homogeneity (sound
pressure level independent of place) and diffuseness (randomly incident
sound at the place of the microphone). This can either be achieved in a
reverberation room with omni-directionally radiating sound source or in an
anechoic room with a number of uncorrelated noise sources. Limited
homogeneity can be achieved in the centre between two speakers. For
good diffuseness a minimum of four speakers distributed in different spatial
directions are required.

A diffuse field or pressure field microphone must be positioned at the spot
of the mouth reference point of the (removed) test head or HATS.

The menu ltem Calibration - Ambient noise field opens the following
window:
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®3l3 Ambient Noise Adjustment

I [=]
Mo Standard |Diffuse field microphone | CHU / CRTU | I
Adjust | Stop Start Enter
Spectium Adjust Level selustment ey ETTEr Change Scals [Ereate HEpart Close

Fig. 22 Measurement window for ambient noise field calibration.

The button “Adjust Spectrum” starts a continuous spectrum measurement
which allows to adjust the spectrum of the noise, e.g. using equalizers. The
template is centred around the curve irrespective of the absolute level.
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Fig. 23 Measurement window for spectrum adjustment.
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The continuous spectrum measurement can be aborted by clicking “Stop
Adjustment”.

The button “Adjust level” starts a continuous level measurement. If a
multitude of sources is used, each source must produce a sound pressure
level of -24 dBPa — 3 * LOG n dB, whereby n is the number of noise
sources.

<3G Ambient Noise Adjustment _[a[=]

Coarse dBPalA) Fine

Mo Standard [Ditfuse fiskd microphone  |CMU # CRTU [ I

Aiist
S

Start.

Stop Erer
Adjustment I sl el

| A st levE] Cammment

| [EHarae Seale [Ereate Hepart (Slose

Fig. 24 Measurement window for level adjustment.

The left thermometer column gives a coarse overview. The right column
has an enlarged scale for fine adjustment.

The continuous level measurement can be aborted by clicking “Stop
Adjustment”.

Once the noise field has been adjusted, the result can be documented by
pressing “Start Measurement”. Although there is no calibration value to be
used in the ambient noise rejection measurement, the level is stored and
can be included for reference in the measurement report.
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3G Ambient Noise Adjustment O]
14
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m Measured, Noise = -23 78 dBPal4)] . Upper limit . Lawwer limit
Mo Standard |Diffuse field microphone | CHU / CRTU | I
Save Curve Az Load Curve sa\ﬁ#ﬁpﬁz A | Meas't?edmenl CoEn?lt:ént Change Scals Create Report Close

Fig. 25 Result of ambient noise calibration.
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Operator

Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is
activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data - Test object > New” a description of the device under test
can be entered.

Test Objeck

M ame

|
Type

M anufacturer

Senal Humber

[ Immediately select this test object

Cancel | | Save and cloze

b

Fig. 26 Window for input of information about a test object

If the checkbox “Immediately select this test object” is checked, the test
object associated with the entered data is automatically selected upon
closing the window. The data of this selected test object will be stored in
association with all measurements and appear on the associated reports if
“DUT information” is activated in the report settings.

A previously entered test object can be selected with “Data > Test object
- Select”.
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General

Special problems caused by the coding and decoding algorithms of mobile
phones are encountered when measuring acoustic characteristics.
Vocoders are used to attain the lowest possible data rate. Mobile phone
voice codecs are optimized for transmitting human speech with low data
rate. Not the actual voice signals but only the filter and fundamental
parameters required for signal reconstruction are transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be
transmitted with such a system. Therefore, the coder and decoder had initially
been excluded from the measurement, which required a specially prepared
test mobile phone with a specific test interface.

In modern mobile phones, this interface is not available anymore.
Measurements are generally performed via the air interface with the speech
coder and decoder included. As mentioned above, measurements using
sinusoidal tones cannot be performed because the static sinusoidal input
signal becomes a more or less stochastic output signal as a result of
coding, particularly in the medium and high audio frequency ranges.

Signals similar to voice therefore have to be used for the measurement, i.e.
either artificial voice according to ITU-T P.50 or a multitone signal according to
ITU-T P.501 is possible. At the same time, modulation of the signal in time must
largely correspond to voice, since many modern mobile phones use algorithms
for interference suppression which use the modulation to distinguish the useful
from the interfering signal.

The test routines in the R&S UPV-K91 use an amplitude-modulated multitone
signal according to ITU-T P.501 as described in 3GPP TS 26.132.

Starting measurements

Measurements can be started from the “Measurement” menu. This menu
contains either all available measurements, or the measurements belonging
to the selected standard if the checkbox “Allow only selected
measurements” in the “Options = Select standard” window is checked.

The menu “Standards” allows to start any measurement, whereby the
measurements are structured into submenus according to the standards to
which they belong. This allows a quick and easy access to all available
measurements.
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3GPPResults.xml)

Standards  Config. Meas. Sequence Report  Options  Help
25M Tvpe 1 Ear 3

3GPP Hands Marrow r 3GPP Sending Handset

3GPP Hands \Wide, Rel, 6/7 r 3GPP Receiving Handsek, nam, Yal

3GPP Hands Wide, Rel & k 3GPP Receiving Handset, nom. Yol, Rel. 8
3GPP Binaural Heads Wide, Rel.3 * 3GPP Receiving Handset, max. Yol

3GPP HHHF Marrow * 3GPP Receiving Handset, min., Yaol,

3GPP HHHF Wide, Rel, 67 r 3GPP Idle channel noise sending

3GPP HHHF Wide, Rel.g r 3GPP Idle channel noise receiving, nom. wal,
3GPP DTHFE Marrow 3 3GPP Idle channel noise receiving, ma:x, val,
3GPP DTHF Wide, Rel, 67 r 3GPP Distorkion sending Rel, 4)5

3GPP DTHF Wide, Rel.g r 3GPP Distarkion sending Rel, &

Configurable Handset k 3GPP Distorkion receiving

Configurable Handsfree * 3EPP Sidetone Masking Rating, LRGP Method
IItilities k 3GPP STMR, HATS Method, Mom, Yal,

Mare ... 3 3GPP STMR, HATS Method, Al Yal, Skeps

3GPP Skahbiliky margin
3GPP Echio loss with training
3GPP Ambient Moise Rejection

AGPF Receiving Handzet, nom. Wal,
AGPF ldle Channel MNoize Sending, W
3AGPP |dle Channel Moize Rec.. nom,

Fig. 27 “Standards” menu with submenu for narrow band handset tests
according to 3GPP TS 26.132.

A third possibility to start a single measurement is the button “Run
highlighted as single measurement” in the sequence menu ( see chapter 7
below).

Functionality and control of the measurement

macros

5]
=
|

Sending senzitivity [dB re 1 Y/Pa]

[] I
100 1000 10000
Frequency [Hz]

¥ Measured, SLR =955 08 [ Upper imit [ Lower imit

3GPP HandS Marow Type 3.2 Low Leak AtEa CMU / CET Sample Object
Save Curve as Add Enter
Save Curve az Load Curve Lirit Fils V| EV e ETTEr Delete Curve Create Report Close

Fig. 28 Example of a measurement window
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When a measurement macro is started, e.g. from the “Measurement’
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

LT

(A el ]

Show Cursor

Zhange Scale

[Daka Poink Size
Comrnenk

Save acreenshot as ..,

Fig. 29 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale M =]

# MininnLmm # I aximum
| 1 EIEI.EIEI::I | 1 EIEIIIIEI.EIEI::I
" kirinnam ol =R

| S000=] | 0.00=]
Cancel ok |
dnce | /

o

Fig. 30 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.

Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.
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Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.

Storing a Hardcopy of the Graph

With the menu item “Save Screenshot as ...” in the graph context menu, a
hardcopy of the current graph window with all numeric displays, legend etc.
can be stored as image. The current view of the graph including additional
curves, current scaling and size is copied. However, colours are inverted to
a printer-friendly colour set.

0
SLR=953dB _|Pass Frequency Re;ponse Iv:argm |= 5.0|9 dB‘ i Pélsls_
_,—A_
= 10 / \
/ - —
z / AT T \
/ _ \
% 20 / = \- \
LS al |
/ L ]\
Pass l
a0 ,/ L \

| 1
a0 1000 10000
Frequency [Hz]

W Measured, SLR = 9.89 dB ,/T/ Upper limit W Lawwer limit

Fig. 31 Hardcopy of measurement graph

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and other result values like
total noise level are calculated and displayed in the legend. The additional
curves and results will appear in the report if item “Store results of further
measurements” had been activated before the measurement was started.
However, limits are not checked for additional measurements.

This function can e.g. be used to find the correct volume setting to pass
nominal RLR. It can further be used for adjustments in the device under
test.

Storing and Loading Curves

All curves in the graph can be stored to an ASCII file (*.tra), and such
curves can be loaded back into the graph. For easy import to Excel the csv
format is also offered. The softkey “Store Curve” opens a window in which a
combo box offers choice between the legends of all curves in the graph.
The curve associated in which the selected entry is stored to the file with
the specified format at the specified location.

If the “Options” menu item “Store loaded curves to results database” is
checked, loaded curves are stored together with the measurement results
and will appear in reports about the measurement.
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Frequency response curves may also be stored as (relativel) UPL-
compatible trace files.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose.

Deleting Additional Curves in the Measurement Graph

By pressing or clicking “Delete Curve”, an additional curve in the
measurement graph can be removed. A window pops up with a combo box
in which the curve to be deleted can be selected. Note that it is not possible
to delete the curve of the first measurement, as this is the measurement for
which the verdict is given. The selected curve disappears from the graph on
the screen and is removed from the database such that it does not appear
in reports anymore.

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K9 main window. All relevant data associated with
the measurement is imported to the results data. A new entry appears for
the measurement as new row on the bottom of the overview data grid in the
main window.
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Notes on Handset Measurements

Applicability of Measurements and Equipment Depending
on the Release

The 3GPP standard is constantly updated according to technical advances
etc. Therefore different versions of the specifications exist in parallel, the
so-called releases. Depending on the release selected for audio testing, the
following rules apply for artificial ears and for the measurements/standards
offered in this version of the UPV-K9x software:

Table 2 Compatibility of equipment and measurements with the releases of
3GPP TS 26.132.

Release |4 |5 |6 |7 |8 |9
Artificial Ears
Ear Type 1 GSMonly | - - - - -
NB
Ear Type 3.2 LL & HL X X X X only | -
Ear Type 3.3 & 3.4 X X X X X X
Standards
GSM Type 1 Ear GSMonly | - - - - -
3GPP HandS Wide, Rel. 6/7 - - X X - -
3GPP HandS Wide, Rel. 8 - - - - X X
3GPP Binaural HeadS Wide, Rel. 8 - - - - X X
3GPP HandS Wide, Rel. 6/7 - - X X - -
3GPP HandS Wide, Rel. 8 - - - - X X
3GPP HandS Wide, Rel. 6/7 - - X X - -
3GPP HandS Wide, Rel. 8 - - - - X X
Measurements
3GPP Receiving Handset, nom. Vol. X X X X - -
3GPP Receiving Handset, nom. Vol., Rel. 8 | - - - - X X
3GPP Distortion Sending, Rel. 4/5 X X - - - -
3GPP Distortion Sending, Rel. 6 - - X X X X
3GPP Sidetone Masking Rating, LRGP
Method X X X X -
from
3GPP STMR, HATS Method - - - 71 * *
3GPP STMR, HATS Method, Rel. 8.2+9 - - - - ** **
3GPP Ambient Noise Rejection X X X X X X
from
3GPP ANR, w. 3 dB Uncertainty Allowance | - 5.1 X X X X
3GPP Ambient Noise Rejection, Wideband | - - X X X X
3GPP ANR, Wideb., Rel. 8, w. 3 dB Uncert.
Allow. - - - - X X

* Applicable for tests according to release 8 as long as version 8.2 of
TS 26.131 and TS 26.132 is not available. Applicable for tests according to
release 9 as long as version 9.2 of TS 26.131 and version 9.1 of TS 26.132
are not available.

** Has to be used for all tests according to release 8 as soon as version 8.2
of TS26.131 and TS 26.132 is available. Has to be used for all tests
according release 9 as soon as version 9.2 of TS 26.131 and version 9.1 of
TS 26.132 are available.
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Sending Frequency Response and Loudness Rating

(“3GPP Sending Handset”, “3GPP Sending Handset Wideband, Rel. 6/77,
“3GPP Sending Handset Wide, Rel.8”)

Sending Frequency Response

The sending frequency response is specified as the transmission ratio in dB
of the voltage at the decoder output to the input noise pressure at the
artificial mouth.

The mobile phone under test is installed in the LRGP (loudness rating
guard-ring position) according to ITU-T P.76, and the receiver is sealed to
the artificial ear.

Tones with a sound pressure of -4.7 dBPa are created with the artificial
mouth at the MRP (mouth reference point), and the corresponding output
voltage is measured at the CMU speech decoder output and evaluated.

The sending frequency response must be within the limit lines specified
according to table 1 of 3GPP TS 26.131. The absolute sensitivity is not yet
taken into account.

Table 3 Sending frequency response limit lines for narrowband according to
table 1 of 3GPP TS 26.131

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -12

200 0

300 0 -12

1000 0 -6

2000 4 -6

3000 4 -6

3400 4 -9

4000 0

Table 4 Sending frequency response limit lines for wideband AMR
according to table 9 of 3GPP TS 26.131, release 6 and 7

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -12
200 0
300 0 -12
1000 0 -6
2000 4 -6
5000 4 -6
6300 4 -9
8000 0
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Table 5 Sending frequency response limit lines for wideband AMR
according to table 9 of 3GPP TS 26.131, release 8

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -6

200 2

300 2 -12

1000 2 -6

2000 4 -6

5000 4 -6

6300 4 -9

8000 0

The offset of the measured frequency response to the upper or lower limit line is
calculated and then the whole limit template is shifted to be centered with
respect to the measured curve. Then another limit check is performed. If the
shifted curve is now within the limit lines, PASS is output, otherwise FAIL is
displayed. The limit check is performed at each measured frequency. If the
measured value and the end point of a limit line are not at the same frequency, it
may happen that the trace slightly crosses a corner of the limit line although
there are no limit violations. The remaining margin is displayed. A negative
margin shows the amount of limit violation.

Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute
loudness in the transmit direction and weights the tones in compliance with
the average speech spectrum and the normal sensitivity of the average
human ear.

To this end, the frequencies (Hz) of bands 4 to 17 (narrowband) or bands 1
to 20 (wideband), resp., are evaluated according to table 1 of ITU-T P.79.

Table 6 Frequencies (Hz) of bands 1 to 20 acc. to table 3 of ITU-T P.79

Band 1 2 3 4 5 6 7

f (Hz) 100 125 160 200 250 315 400
Band 8 9 10 11 12 13 14
f (Hz) 500 630 800 1000 1250 1600 2000
Band 15 16 17 18 19 20

f (Hz) 2500 3150 4000 5000 6300 8000

The sensitivity in dBV/Pa at each frequency is defined as the difference
between the level at the network interface (digital level measured at the
analog CMU speech output) and the sound pressure level at the mouth
reference point (MRP), and the sending loudness rating is calculated
according to formula 5-1 of ITU-T P.79. The weighting factors are taken
from ITU-T P.79, table A2 for narrowband and for wideband according to
release 8, and from ITU-T P-79, table G1 for wideband according to release
6 and 7. Note that loudness rating values are loss values, i.e. a high
loudness rating values indicates a low gain and a low loudness rating value
indicates a high gain.
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Due to the input sensitivity tolerance of the CMU speech coder, the
individual sensitivity of the CMU used has to be taken into account in order
to calculate the sending loudness rating (see calibration routines).
According to 3GPP TS 26.131, the sending loudness rating should be
between 5 dB and 11 dB, with lower dB values corresponding to greater
loudness (5 dB = maximum loudness, 11 dB = minimum loudness). The
measured SLR is indicated in a window in the frequency response display
and checked for compliance with these limits. In addition to the numeric
value, either PASS or FAIL is displayed.

The general PASS or FAIL information is obtained from the limit check of the
frequency response curve and the loudness rating. PASS is output only if both
the curve and the loudness value are within tolerances.
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Fig. 32 Sending frequency response with SLR value displayed
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Receiving Frequency Response and Loudness Rating

(“3GPP Receiving Handset, nom. Vol.”, "3GPP Receiving Handset, nhom.
Vol., Rel.8”, “3GPP Receiving Handset, max. Vol.”, “3GPP Receiving
Handset, min. Vol.”, “3GPP Receiving Handset, nom.Vol., Wide, Rel. 6/7,
“3GPP Receiving Handset, max.Vol., Wide, Rel. 6/7” ,"3GPP Receiving
Handset, min.Vol., Wideband”, “3GPP Receiving Handset, nom.Vol., Wide,
Rel. 8”, “3GPP Receiving Handset, max.Vol., Wide, Rel. 8", “3GPP Rec. Bin
Headset, Nom. Vol., Wideband, Mon. meas.”, “3GPP Rec. Bin Headset,
Nom. Vol., Wideband, Bin. meas.”, “3GPP Rec. Bin Headset, Max. Vol.,
Wideband, Mon. meas.”, “3GPP Rec. Bin Headset, Max. Vol., Wideband,
Bin. meas.”, “3GPP Rec. Bin Headset, Min. Vol., Wideband, Mon. meas.”,
“3GPP Rec. Bin Headset, Min. Vol., Wideband, Bin. meas.”)

The following three measurement definitions are available, as the
permissible limit values of the loudness rating depend on the volume set in
the mobile phone under test: “3GPP Receiving Handset, nom. Vol” checks
loudness rating limits for nominal loudness setting and at the same time
compliance with the frequency response limit template. “3GPP Receiving
Handset, max. Vol.” checks the receiving loudness rating at the highest
volume setting against a minimum. “3GPP Receiving Handset, min. Vol.”
checks the receiving loudness rating at the lowest volume setting against a
maximum. (Note: As the loudness rating is a loss value, a high RLR is
associated with a soft speech signal and a low RLR is associated with a
loud speech signal).

Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio in
dB of the sound pressure in the artificial ear to the rms value at the network
interface, applied as input voltage at the speech coder input of the CMU.
The measured sound pressure is referenced to the ear reference point
(ERP). For ear type 1, the measuring microphone is directly applied to the
ERP and no further correction is required. For ear types 3.x, the measuring
microphone is applied to the drum reference point (DRP), which is the
reason why any measured value has to be converted to the ERP by means
of calibration factors. For special purpose there are separate
measurements supplied with R&S UPV-K91 which measure the sound
pressure referenced to the DRP.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS. In case of ear type 1, the receiver is sealed to knife edge of the
artificial ear. In case of ear type 3.2, the receiver is sealed to the rubber
gasket of the artificial ear. If the low leak version of this ear type is used,
care must be taken that the defined leak opening at the circumference of
the artificial ear is not accidentally covered.

The speech coder is driven such that tones with a system reference level of
-16 dBmO are obtained. The sound pressure in the artificial ear is measured
and evaluated.

Ear type 1 will no longer be used for measurements on 3GPP mobile
phones. Therefore, 3GPP TS 26.131 defines limit values only for ear types
3.x, whereas the limit values specified in 3GPP TS 51.010 (previously GSM
11.10) are still valid for ear type 1.
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Table 7 Limit lines according to table 30.2 of 3GPP TS 51.010 (ear type 1)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 -10

200 0

300 2 -7

500 * -5

1000 0 -5

3000 2 -5

3400 2 -10

4000 2

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.

Use tests “3GPP GSM Rel. 4 Receiving Handset, nom. Vol”, “3GPP GSM
Rel. 4 Receiving Handset, max. VoI, “3GPP GSM Rel. 4 Receiving
Handset, min. Vol” for receiving tests with type 1 artificial ear.

When ear type 1 is used, the receiving frequency response must be within
the limit lines specified in table 30.2 of 3GPP TS 51.010. When ear type 3.x
is used, it must be within the limit lines specified in table 2 of 3GPP TS
26.131. In the frequency response curve, the limit template is shifted to be
centred with respect to the displayed absolute sensitivity.

Table 8 Limit lines for narrowband receiving frequency response
according to table 2 of 3GPP TS 26.131, up to release 7 (ear type 3.x)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
70 -10

200 2

300 * -9

500 * *

1000 * -7

3000 * *

3400 * -12

4000 2

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.
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Table 9 Provisional limit lines for narrowband receiving frequency
response according to table 2 of 3GPP TS 26.131, from release 8 (ear type
3.x), for further study

Frequency (Hz) Upper limit (dB) Lower limit (dB)
100 6 -

200 6 -

300 6 -6

1000 6 -6

2000 8 -6

3400 8 -6

4000 8 -

* Intermediate values are obtained by drawing a straight line between the specified values
and using a logarithmic frequency scale and a linear dB scale.

Table 10 Limit lines for wideband receiving frequency response
according to table 10 of 3GPP TS 26.131, release 6 and 7 (ear type 3.x)
Frequency (Hz) Upper limit (dB) Lower limit (dB)
70 -10
200 2
300 * -9
500 * *
1000 * -7
3000 * *
3400 * *
6300 * -14
8000 2
Table 11 Limit lines for wideband receiving frequency response

according to table 10 of 3GPP TS 26.131, release 8 (ear type 3.x)

Frequency (Hz) Upper limit (dB) Lower limit (dB)
70 6

200 6 -10

300 6 -6

1000 6 -6

2000 8 -6

5000 8 -6

6300 8 -12

8000 8

The margins of the measured frequency response to the upper and lower
limit lines are calculated separately, and then the whole template is shifted
such that the resulting margins to upper and lower limit are equal. Then
another limit check is performed. If the shifted curve is now within the limit
lines, PASS is output, otherwise FAIL is displayed. The limit check is performed
at each measured frequency. If the measured value and the end point of a limit
line are not at the same frequency, it may happen that the trace slightly crosses
a corner of the limit line although there are no limit violations. The remaining
margin is displayed. A negative margin shows the amount of limit violation.
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Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute
loudness in the receive direction and weights the tones in compliance with
the difference between an average speech spectrum and the normal
threshold of hearing in quiet of the average human ear.

To this end, the frequencies (Hz) of bands 4 to 17 (narrowband) or bands 1
to 20 (wideband), resp., are evaluated according to table 1 of ITU-T P.79
(see table 4)

The sensitivity at each frequency is specified as the ratio dBPa/V,
calculated from the level difference between the level at the network
interface (measured at the analog CMU speech decoder output) and the
sound pressure level at the artificial ear, referenced to the ERP, and the
receiving loudness rating is calculated according to formula 5-1 of ITU-T
P.79. The weighting factors are taken from ITU-T P-79, table A2 for
narrowband and for wideband according to release 8, and from ITU-T P-79,
table G1 for wideband according to release 6 and 7.

Due to the output gain tolerance of the CMU speech decoder, the individual
sensitivity of the CMU used has to be taken into account in order to
calculate the receiving loudness rating (see section “Calibration” above).

The receiving loudness rating depends on the volume setting on the mobile
phone under test and, according to 3GPP TS 26.131, should be between
-1 dB and +5 dB for narrowband and for wideband according to release 8,
and between 2 dB and 8 dB for wideband according to release 6 and 7,
obtained at a rated (“nominal”) loudness setting, with lower dB values
corresponding to a higher loudness.

The RLR must not fall below -13 dB (-10 dB for wideband in release 6 and
7) when maximum loudness is set on the mobile phone. To prevent
damage to the human ear, the maximum receiving loudness must not
exceed a certain value.

The measured RLR is indicated in a window in the frequency response
display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

With “3GPP Receiving Handset, nom. Vol”, the general PASS or FAIL
information is obtained from the limit check of the frequency response
curve and the loudness rating. PASS is output only if both the curve and the
loudness value are within tolerances.

“3GPP Receiving Handset, max. Vol checks only the RLR against a
minimum of -13 dB. The frequency response curve is shown for information
only.

“3GPP Receiving Handset, min. Vol” checks the RLR against a maximum
of +18 dB.
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Fig. 33 Receiving frequency response with RLR value displayed
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Sidetone Masking Rating (STMR)

(“GSM Rel. 4 Sidetone Masking Rating”, “3GPP STMR, LRGP Method”,
“8GPP STMR, HATS Method, Nom. Vol.”, “3GPP STMR, HATS Method, all
Vol. Steps”, “3GPP Sidetone Masking Rating, LRGP, Wideband”, “3GPP
STMR, HATS, Nom. Vol., Wideband”, “3GPP STMR, HATS, All Vol. Steps,
Wideband”, “3GPP Bin. Headset, Nom. Vol., Wideband, Rel. 8", “3GPP
STMR, HATS Method, Nom. Vol., Rel. 8.2+9”, “3GPP STMR, HATS
Method, all Vol. Steps, Rel. 8.2+9”, “3GPP Sidetone Masking Rating,
LRGP, Wide, Rel. 8.2+9”, “3GPP STMR, HATS, Nom. Vol., Wide, Rel.
8.2+9%, “3GPP STMR, HATS, All Vol. Steps, Wide, Rel. 8.2+9”, “3GPP Bin.
Headset, Nom. Vol., Wide, Rel. 8.2+9” )

The sidetone path is the deliberate output of a part of the signal picked up
by the microphone to the phone's receiver. This is to create a natural
hearing impression for the person speaking on the phone as is encountered
under normal conditions involving an acoustic path between mouth and ear.

Up to release 7.0 the STMR can only be measured according to standard
using ear type 3.2 (low leakage) (“3GPP STMR, LRGP Method”). Up to
release 4, ear type 1 may alternatively be used for 3GPP TS 51.010 only
(“3GPP GSM Rel. 4 Sidetone Masking Rating”). For these tests the mobile
phone under test is installed in the LRGP (ITU-T P.76), and the receiver is
sealed to the artificial ear.

From release 7.1 it is also possible to use ear type 3.3 or 3.4 for this test.
“3GPP STMR, HATS Method, Nom. VoI’ has to be passed in the nominal
setting of the user volume control. “3GPP STMR, HATS Method, All Vol.
Steps” has to be passed in all (other) settings of the volume control.

The artificial mouth generates tones with a sound pressure of -4.7 dBPa at
the MRP (mouth reference point), and the sound pressure is measured in
the artificial ear.
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The attenuation of the sidetone path is determined at each frequency
according to table 1 of ITU-T P.79, and the sidetone masking rating (STMR)
is calculated according to formula 5-1 of ITU-T P.79 with the weighting
factors of table 3 of ITU-T P.79 taken into account. In addition, the gain of
the sidetone path is displayed as a curve.

When the phone is set to nominal receiving loudness, the STMR should be
within 13 dB and 23 dB according to 3GPP TS 26.131 when the LRGP
method is applied. With the HATS method, the target STMR is between
12 dB and 20 dB at nominal volume setting. At all other volume settings, the
STMR must not be below 8 dB with the HATS method.

From version 8.2 and 9.2 of TS 26.131 the target STMR range for the
HATS method has been changed to within 13 and 23 dB. From Version 8.2.
and 9.1 of TS 26.132 the weighting factors for unsealed condition of ITU-T
P.79 Table B2 have to be used for the STMR calculation. These changes
are taken into account with the test cases according to “Rel. 8.2+9”.
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Sidetone Delay
(“3GPP Sidetone Delay”, “3GPP Sidetone Delay, Binaural”)

The sidetone delay measurement is only specified from release 8 of the
3GPP specifications, and only for wideband AMR. Digital signal processing
in the sidetone path can cause a delay of the sidetone, which would result
in an annoying local echo in the handset or headset.

The test produces a short click in the artificial mouth and analyzes the
amplitude-over-time response at the artificial ear, starting from the time
when the click was produced at the artificial mouth. The first occurring
maximum after approx. 1 ms is associated with the acoustic propagation
from the HATS mouth to the HATS ear. There may be more maxima during
the first milliseconds due to different propagation paths around the head.
The time difference between the last occurring maximum exceeding a pre-
defined level difference to the noise floor in the observed period, and the
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first peak, is defined as sidetone delay. This value must not exceed 10 ms.
If no significant maximum is found before 8 ms from the start of the click at
the artificial mouth, the sidetone delay is defined to be smaller than 8 ms. In
the measurement window, “< 8ms” is displayed as result whereas in the
report the value will be simply displayed as “0 ms”.
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Fig. 35 Typical sidetone delay result
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Echo Loss (TCLw)
(“3GPP Echo loss with training”, “3GPP Echo loss without training”, )

The echo loss is the attenuation between the speech coder input and the
speech decoder output (gain of speech coder + decoder = 1). Normally the
echo is caused by internal acoustic coupling between the telephone
receiver and the microphone. Since the echo considerably reduces the
sound transmission quality, it must not exceed a certain level.

The mobile phone under test is suspended in free air in the anechoic test
chamber (previous specifications used the LRGP).

A modulated multitone signal according to ITU-T P.501 is generated as a
test signal and applied to the speech coder. First, the spectral energy
distribution of the generated signal is measured in the third-octave bands
from 200 Hz to 4 kHz. Then, the spectral distribution in the output signal of
the speech decoder is measured. The echo loss is calculated from the
differences of the bands according to ITU-T G.122. According to 3GPP
TS26.132, the mobile phone under test has to be fed for approx. 10 s with
the male and female version of artificial voice according to ITU-T P.50 prior
to this measurement. This training sequence is to facilitate optimization for
potential echo cancellers. A quicker test without training sequence is
available as “3GPP Echo loss without training”.

The actual gain of the speech coder and decoder must also be considered in
the result. These values are obtained during codec calibration.
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In addition, the attenuation of the echo path is displayed as a curve.

3GPP TS 26.131 specifies an echo loss of at least 46 dB; mobile phones
with good echo cancellers can meet this requirement. Since the
microphone of the mobile phone under test also picks up any side noise
and treats it like an echo, it is essential that the test chamber is well
shielded against external noise.
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Stability Margin
(“3GPP Stability margin”)
The stability margin is measured to test the susceptibility of the phone to

acoustic feedback and instability.

For the test, the telephone is placed on an even, hard board with the
receiver and microphone pointing downwards.

A loop is closed in the R&S UPV between the receiving and the voice
channel, and an overall gain of 6 dB is set. The gain of the coder is
automatically taken into account (see also Echo Loss).

To activate the loop, a noise signal of -10 dBmO in line with ITU-T 0.131 is
applied for 1 s and then switched off, with the loop remaining closed.
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Fig. 37 Window during stability margin test
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The test person has to listen to determine whether any resonances or
oscillations are produced. If there are no oscillations, the minimum
requirements according to 3GPP TS 26.131 for a stability margin of 6 dB
are met.

Sending Distortion

(“3GPP Distortion sending, Rel. 4/5”, “3GPP Distortion sending, Rel. 67,
“3GPP Distortion Sending Wideband, Rel. 6/7”, “3GPP Distortion Sending
Wide, Rel. 8”)

The SINAD ratio in the transmit path is measured as a function of the sound
level.

A pulsed sinusoidal tone of 1015 Hz with a pulse length of approx. 340 ms
is used for the measurement. At this frequency, coding yields a sufficiently
stable output signal. Voice activity detection continues to be active in the
mobile phone under test due to this pulsating signal.

The mobile phone under test is installed in the LRGP or on the HATS.

The test signal is generated with the artificial mouth at the MRP (mouth
reference point) and the SINAD value of the received signal is measured at
the CMU decoder output.

The acoustic reference level (ARL) is defined as the sound pressure which
creates a signal level of -10 dBmO in the transmit channel. An automatic
routine varies the sound pressure at the artificial mouth until the desired
level is attained. This value is then used as a reference for determining the
SINAD value versus level.

The SINAD value is measured at sound pressures between -35 dB and
+10 dB relative to the acoustic reference level (ARL) and compared with the
limits specified in table 7 of 26.131 of 3GPP.
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Signal processing of a modern mobile phone comprises a voice activity
detector which determines whether a voice signal is present or whether the
sending signal just comprises background noise. With such mobile phones
the sending distortion test according to 3GPP TS 26.132 before release
6.0.0 may be failed at low levels because the 1 kHz sinewave test signal is
classified as background noise and suppressed. For this reason the
sending distortion measurement according to release 6.0.0 and onwards
omits levels below -25 dB and starts at high test tone levels gradually
reducing the level. For this release, use “3GPP Distortion sending, Rel. 6”,
for earlier releases use “3GPP Distortion sending, Rel. 4/5”.

Table 12 Limit lines specified in table 7 of 3GPP TS 26.131
dB relative to ARL | Level ratio
-25dB 26.6 dB
-20dB 30.7 dB
-10 dB 33.3dB
0dB 33.7dB
7dB 31.7dB
10 dB 25.5dB

The measurement is performed up to a maximum sound pressure of 10 dBPa
at the artificial mouth if the value 10 dB relative to ARL with 10 dBPa cannot be
attained. The actual trace may therefore end at a lower pressure. This occurs
for mobile phones under test which have a low sensitivity in the transmit
direction.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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For tests in WB-AMR mode starting from release 8 of 3GPP TS 26.131 and
TS 26.132, additional measurements are performed at the frequencies of
315 Hz, 408 Hz, 510 Hz and 816 Hz with a SPL of -4.7 dBPa at the MRP.
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Other than in the previous version of the test, the levels are not defined
relative to ARL, but as absolute SPL at the MRP. An activation signal is
issued before each measurement to activate the VAD (voice activity
detector) of the mobile under test. To avoid an impact of the activation
signal on the result due to the processing delay in the transmission chain,
the test routine comprises a delay measurement. The start of the analysis is
delayed against the start of the test signal by the measured delay time.

Table 13 Limits specified in table 15 of 3GPP TS 26.131, release 8.

Frequency Sending level Sending Ratio (dB)
(dBPa at the MRP)

315 Hz -4,7 [28]
408 Hz -4,7 [32]
510 Hz -4,7 [32]
816 Hz -4.7 [32]
1020 Hz -20 [27]
-15 [30]

-10 [33]

-4,7 [35]

0 [35]

+5 [30]
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Receiving Distortion

(“3GPP Distortion receiving”, “3GPP Distortion Receiving Wide, Rel.8’,
“3GPP Dist. Rec. Wide, Binaural, Rel. 8”)

The SINAD ratio in the receiving path is measured as a function of the acoustic
signal level.

A pulsed sinusoidal tone of 1015 Hz is used for the measurement. At this
frequency, coding yields a sufficiently stable output signal.

Voice activity detection continues to be active in the mobile phone under
test due to this pulsating signal.
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The mobile phone under test is installed in the LRGP (ITU-T P.76) with the
receiver is sealed to the artificial ear, or on the HATS.

The test signal is applied to the input of the CMU speech coder, and the
SINAD value of the sound pressure in the artificial ear is measured with
psophometric weighting according to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45dBm0 and 0 dBmO and compared with the limits given in table 8 of
3GPP TS 26.131.

Table 14 Limit lines specified in table 8 of 3GPP TS 26.131
Level Level ratio
-45 dBm0 17.5dB
-40 dBm0O 22.5dB
-30 dBm0 30.5dB
-20 dBm0 33.0dB
-10 dBm0 33.5dB
-3 dBmO0 31.2dB
0 dBmO 25.5dB

The measurement is performed up to a maximum sound pressure of
10 dBPa in the artificial ear; the actual trace may end at an earlier point.

If the operator desires to see the receiving distortion value at the point
exceeding 10 dBPa, this can be achieved by pressing the “add
measurement” button. This causes the measurement to be repeated at all
specified levels. The second measurement is not taken into account for
reporting and Pass/Fail decision.

If the measured trace is above the limit line, PASS is output, otherwise FAIL
is displayed.
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Fig. 40 Typical result of receiving distortion measurement
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Table 15 Limits specified in table 16 of 3GPP TS 26.131, rel. 8
Receiving level Receiving ratio
Frequency at the digital at nominal volume
interface (dBm0) setting (dB)
315 Hz -16 [20]
408 Hz -16 [28]
510 Hz -16 [28]
816 Hz -16 [28]
-45 [17,5]
-40 [22,5]
-30 [30,5]
-20 [33,0]
1020 Hz 16 [33.5]
-10 33,5
-3 31,5
0 25,5

For tests in WB-AMR mode starting from release 8 of 3GPP TS 26.131 and
TS 26.132, additional measurements are performed at the frequencies of
315 Hz, 408 Hz, 510 Hz and 816 Hz with a digital level of -16 dBmO0 at the
network interface (encoder input). An activation signal precedes the test
signal. To avoid an impact of the activation signal on the result due to the
processing delay in the transmission chain, the test routine comprises a
delay measurement. The start of the analysis is delayed against the start of
the test signal by the measured delay time.

& 3GPP Distortion Receiving Wide, Rel. 8

a0 a0
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Receiving sighal-to-distartion ratio [dB]
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m Measured . Lower Limnit E Measured . Lawwer Lirnit
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Fig. 41 Typical result of receiving distortion measurement in wideband
according to release 8.
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Idle Channel Noise Sending

(“3GPP Idle channel noise sending”, “3GPP Idle Channel Noise Sending,
Wideband”)

The noise voltage at the speech decoder output is measured with the
phone set up in a quiet environment (<30 dB(A)).
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The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS.

The decoder output voltage is measured, weighted and recalculated for the
internal level in dBmOp.

For the narrow band test, the weighting is done psophometrically according
to ITU-T G.223. For the wideband version of the test, A weighting according
to IEC 60651 is applied.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied. The noise level is measured during the signal
pauses. The voice activity decoder (VAD) is activated and the mobile phone
remains in the active normal sending mode.

The idle noise level should not exceed -64 dBmOp. The measured noise
voltage is also displayed as a spectrum, making it easier to find causes if
the limit value is exceeded.

@ 3GPP Idle channel noise sending _[O]x

30

-40

-50

-60

CCITT-weighted spectum [dB]

70

50

-390

-100 - ]
100 1000 10000
Frequency [Hz]

B tieasured, Moise = -77.90 dBmil[F)

3GFP Hands Namow | Type 3.2 Low Leak AitEa | CHU / CET |5 ampie Objsct [

Save Curve as | Load Curve

Fig. 42 Typical result of sending noise measurement
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Idle Channel Noise Receiving

(“3GPP Idle channel noise receiving, nom. Vol”, “3GPP Idle channel noise
receiving, max. Vol”, “3GPP Idle Channel Noise Rec., Nom. Vol., Rel. 8’
“3GPP Idle Channel Noise Rec., Max. Vol., Rel. 8", “3GPP Idle ch. noise
rec.,binaural, nom. vol., Rel. 8”, “3GPP Idle ch. noise rec., binaural, max.
vol., Rel. 8”)

The sound pressure in the artificial ear is measured with the phone set up in
a quiet environment.

The mobile phone under test is installed in the LRGP (ITU-T P.76) with the
receiver sealed to the artificial ear, or mounted on the HATS.

The sound pressure in the artificial ear is measured with A-weighting on.

To keep the mobile phone under test in the normal operating mode, a
pulsed signal is applied to the speech coder input. The noise level is
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measured during the signal pauses. The voice activity decoder is activated
and the mobile phone remains in the active normal receiving mode.

With rated loudness set on the mobile phone, the sound pressure should
not exceed -57 dBPa(A). In this case use test “3GPP Idle channel noise
receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed
-54 dBPa(A). In this case use test “3GPP ldle channel noise receiving, max.
Vol”.

The measured noise voltage is also displayed as a spectrum, making it
easier to find causes if the limit value is exceeded.
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Fig. 43 Typical result of receiving noise measurement
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This measurement makes high demands on the sound insulation of the test
chamber and the S/N ratio of the measuring microphone including
preamplifier in the artificial ear. A comparison measurement with the test
mobile phone switched off or without a DUT shows the measurement
reserves of the test equipment. Due to the inherent noise of the Audio
Analyzer R&S UPV, measurements can be made to about -80 dBPa(A) at
0 dB microphone gain, and even to lower values when a higher microphone
gain is set.

Ambient Noise Rejection

(“3GPP Ambient Noise Rejection”, “3GPP ANR, w. 3dB uncert. allow.”,
“3GPP Ambient Noise Rejection, Wide, Rel. 6/7”, “3GPP Ambient Noise
Rejection, Wide, Rel. 8", “3GPP ANR, Wide, Rel. 8, w. 3dB uncert. allow.”)

Ambient noise rejection describes the weighted ratio of voice signal
transmission to transmission of ambient noise. An ANR value >0 dB means
that voice as the useful signal is transmitted more loudly than any ambient
noise. The minimum requirement according to 3GPP TS 26.131 is
ANR > 0 dB. A value >= 3 dB is recommended. From version 5.1 (with the
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exception of wideband measurement according to release 6 and 7), an
additional allowance of 3 dB should take measurement tolerances into
account, such that the effective minimum value is -3 dB.

To perform this measurement, a homogeneous noise field for simulating
the noise in the environment has to be generated. This sound field must be
generated by additional loudspeakers and noise generators. To obtain a
sufficiently homogeneous sound field, several uncorrelated generators and
loudspeakers are required. The use of 2 to 8 generators and loudspeakers
is common practice. The noise sources have to generate pink noise
(spectral power density ~ 1/f). The permissible error in the relevant third-
octave bands must be smaller than +3 dB with the frequency response of
the loudspeakers used also being taken into account.

This adjustment and testing of the sound field is done as a calibration
process (see section 4 above). With sufficient long-term stability of the
noise generators and loudspeakers it can be used for a number of
subsequent tests. Alignment of the noise field has to be repeated if anything
in the setup of the noise sources (loudspeaker position, amplifier gain etc.)
is changed. Furthermore it is recommended to check the noise field in
regular intervals.

After the noise field calibration, the artificial mouth and the artificial ear
must be installed again for the actual measurement of ANR. The MRP must
be installed at the same position as the reference microphone had during
the calibration of the noise field.

The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the
HATS (ITU-T P.58). If installed on the LRGP, the receiver is sealed to the
artificial ear.

Set up a call to the CMU and set the bit stream to "Handset Low" (GSM) or
the dedicated channel voice to "Speechcodec Low" (WCDMA).

At first the noise spectrum picked up by the phone and sent on the uplink is
measured. After completion of the measurement, the request to switch off
the noise field will be displayed on the screen. If this is confirmed, the
speech sending sensitivity will be measured automatically and the ANR
value will be calculated afterwards.

The minimum value in the tests named “..., w. 3 dB uncert. allow.” is -3 dB.
In all other ANR tests the minimum requirement is 0 dB.
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Fig. 44 Typical result of ambient noise rejection measurement
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The graph displays the difference of the room noise sensitivity and the
speech sending sensitivity (DELSM) for information.

Notes on Hands-Free Measurements

General Remarks

The standards 3GPP TS 26.131 and TS 26.132 define requirements and
test specifications for the tests of the acoustic behaviour of the mobile
phone in this mode, but not all details are specified yet.

UPV-K91 3GPP Mobile Phone tests provide test cases for handheld hands-
free and desktop hands-free mode with narrow band and wideband speech.
Test specifications and limits for hands free car kits are the same as for
desk top hands-free terminals.

Hands-free tests with UPV-K91 support the use of either artificial mouth
according to ITU-T P.51 together with a free field measurement microphone
or alternatively the use of a HATS with type 3.3 or 3.4 artificial ear and
artificial mouth according to ITU-T P.58.

Test Setup

All tests must be performed in an anechoic room. Background noise must
be less than 24 dBSPL(A). Furthermore the room should be big enough and
its walls should have sufficient absorption to provide nearly free-field
conditions at the hands-free reference point. Not all test boxes which are
appropriate for handset tests can be used for hands free measurements.

If a free-field microphone with a discrete P. 51 mouth is used, it should be
configured to the Handheld hands-free UE as per Figure 12 for receiving
measurements and Figure 13 for sending measurements. The
measurement instrument should be located at a distance dyr from the
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centre of the visual display of the mobile station. The distance dyr is
specified by the manufacturer.

Normal vector
from front of phone

|
Free-field measurement :
microphone R e e e e S S S e i <

Bam -~

Fig. 45 Configuration of handheld hands-free UE, free-field microphone
for receiving measurements

Lio i Normal vector
Ip ring from front of phone

position

£

Fig. 46 Configuration of handheld hands-free UE, free-field microphone for
receiving measurements

If a HATS is used, the measurement can either be performed binaurally
(with two artificial ears and correction of the RLR by 6 dB) or monaural.

The selection of acoustic accessories used for the hands free tests can be
entered in menu item “Options - Hands free settings”.
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Hands Free Settings

LRGP ITU-T P.51 and free field
microphone

HaTs [TU-T P.58 and type 3.3
artificial ear, monaral

HaTs [TU-T P.58 and type 3.3
artificial ear, binaural

HaTs ITU-T P.58 and type 3.4
artificial ear, monaral

HaTs ITU-T P.58 and type 3.4
artificial ear, binaural

Generc speaker and free field
microphone

Cancel k. /L
2

Fig. 47 Hands free settings

b s ',

HATS y i
Reference I Normal vector

Point | from front of phone

Fig. 48 Configuration of handheld hands-free UE with HATS

For desk top hands-free it is referred to ITU-T P. 340 (http://www.itu.int) for
the use of free field microphone and discrete P.51 mouth. The hands free
terminal should be placed on a table of approximately 1 m? with the centre
of its front edge 400 mm perpendicularly from the centre of the front edge
of the table. The surface area should not be less than 0.96 m” and its width
should not be less than 0.8 m. The front centre of the measuring
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microphone or centre of the lip ring, respectively, should be placed 300 mm
above the centre of the front edge of the table with the axis of the
microphone or artificial mouth inclined towards the centre of the front edge
of the hands-free terminal.

For the use of a HATS with both types of hands-free terminals it is referred
to ITU-T P.581. For handheld hands free the setup of ITU-T P.581
corresponding to “portable hands-free” should be used. For desk top
hands-free, the centre of the lip ring is positioned as described above, but
the axis of the artificial mouth should be horizontal.

Acoustic Calibration for Hands Free Tests

The calibration for the free field microphone or type 3.3 or type 3.4 HATS
ear, respectively, is done as described in chapter 4 above.

For binaural measurements, the second artificial ear has to be calibrated
accordingly, using the sub-item “Second Type 3.3 ear” or “Second type 3.4
ear”, respectively, in “Calibration - Artificial Ear’. Note that the second
artificial ear must be connected to Analyzer input 2 instead of the CMU
connection.

According to 3GPP TS 26.132, free field equalization has to be taken into
account. Free field data can either be imported as an average table from
the standard or from an individual calibration disk, using the menu item
“Calibration - Free field equalization”.

The calibration of the artificial mouth for hands free tests comprises two
additional steps. After the level has been adjusted and the frequency
response has been equalized at the MRP, the reference microphone has to
be repositioned at the so-called Hands-Free Reference Point (HFRP or
HATSHFRP).

For the mouth according to ITU-T P.51 the HFRP is in 50 cm distance from
the lip ring on the axis of the mouth. The calibration has to be performed at
this point independent of the measuring distance currently used.

The HATS HFRP is stipulated in ITU-T P.581. It is one of the points 11 to
17 defined in table 6a of ITU-T P.58. It should be on the axis which is
closest to the actual axis from the lip ring to the microphone under test. The
distance is always 50 cm from the lip ring. The axis may be azimuthally
centric (i.e. 0° horizontally) with an elevation (vertical) angle of 0°, +15° or
1+30°. Points 16 and 17 are located on an axis with 0° elevation and an
azimuth angle of 15° or 30°.

The level at this point is adjusted to -28.7 dBPa. For the last step, the
reference microphone is returned to the MRP, and the level and spectrum
at the MRP are measured as reference for the transfer function calculation.

The mouth calibration for hands-free tests is started with the menu item
“Calibration > Atrtificial Mouth (Hands Free)”. This procedure comprises the
mouth calibration for handset tests and has also effect on subsequent
handset tests with the same individual artificial mouth.

“Utilites” Measurements

This item of the “Standards” menu contains useful measurements which
are either from other standards or for checking test conditions.
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Sidetone Distortion

A sidetone distortion test is specified in 3GPP TS 51.010 30.8 for
measurements using the DAI. As the downlink conveys only silence during
this test, it is, however, more or less independent of the kind of
transmission between system simulator and mobile. The sidetone distortion
test determines 3™ order harmonic distortion at a given set of frequencies
(in the case of TS 51.010 at 315, 500 and 1000 Hz) with a level of -4.7
dBPa at the MRP. The third order harmonic distortion is required to be less
than 10 % (-20 dB) at all frequencies.
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Fig. 49 Sidetone distortion test
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Gain Variation Tests

Gain variation tests in sending and receiving direction are specified in 3GPP
TS 43.050 Annex C.5. The limits given in TS 43.050, sections 3.9.1 and
3.9.2 are meant for measurement over DAI and cannot be fulfilled when a
Codec is in the transmission chain. The configurable versions of the gain
variation tests allow to define specific limit curves.
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Fig. 50 Sending gain variation test

61 E-4



1402.0043.12

Acoustic Measurements on Mobile Phones

Delay Measurements

Sending and receiving delay can only be measured end-to-end, i.e. from the
acoustic origin of the artificial mouth to the decoder output of the system
simulator or from the encoder input of the system simulator to the DRP.
The measurements offered with R&S UPV-K91 allow to subtract the
estimated delay of the CMU from the total measured value. As the data is
interleaved on the air interface, no exact time instance can be determined
when the audio data are transmitted between mobile phone and system
simulator. The values used in the present measurements are estimations
with an uncertainty of about 10 ms. The delay measurement is performed
for a given set of frequencies, and an average is calculated over all
frequencies.
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Fig. 51 Sending delay measurement
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Background Noise Measurements

3GPP TS 26.132 demands the background noise in the test room to be
below -64 dBPa(A) for idle channel noise measurements and below
-30 dBPa(A) for all other handset measurements. For hands free
measurements the background noise needs to be below -70 dBPa. The
background noise measurements offered in R&S UPV-K91 check the
overall noise level against these limits and display the spectrum of the
noise. A lower limit assures that the test is not erroneously passed if no
microphone is connected or the microphone supply is switched off. The test
requires a diffuse field (pressure field) microphone to be connected to
analyzer input 1 and to be placed in the test room, preferably at the place of
the MRP.
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Fig. 52 Background noise measurement
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If the noise in the test room does not fulfil the requirements it may first be
attempted to remove noise sources in the vicinity of the test chamber. If no
further reduction is possible, the sound isolation of the chamber should be
improved. This can be achieved e.g. by heavier walls. Low frequency noise
may possibly be conducted as structure borne sound, which may be
reduced by an isolating support of the chamber. High frequency noise can
be caused by a leakage e.g. at the door and may be reduced by an
improved gasket.
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6 Customizing Measurements

Measurements which implement a test case of a standard are locked and
cannot be edited. However, for each measurement type there is also a
configurable measurement provided, in which the limits can be customized.
The parameters of the measurements are accessible through the menu
item “Config. Meas.”

| Config. Meas, Sequence Repork  Options  Help
Configurable Handset ambient Maoise Rejection with Modulated Mulkisine
Configurable Handsfree  » Echo loss with modulaked mulkisine

Receiving Handset with modulated mulkisine

BCENVING

i Sidetone Masking Rating with Modulated Multisine
- Sending with modulated multisine

eceiving

Peak Acoustic Pressure Level with Signal "PeakLewvel"
Distartion receiving

andset wideband
zending wideband
andset wideband
andset wideband
andset wideband
andset wideband
zending wideband

Idle channel noise receiving
Distortion sending

Idle channel noise sending
Skahility rarain

Sidetone Distorkion {generic)
Sending Gain Yariakion

andzet wideband

sending wideband Receiving Gain Yariakion

eCEving Sending Delay

andzet

_ Background noise measurement (generic)

Fig. 53 Measurement configuration menu

Receiving Delay

Clicking on one of the entries opens a window in which all parameters can
be viewed and most of them can be customized:
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Fig. 54 Measurement parameters window
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As Sequences create copies of the parameter files, each instance of a
measurement in a sequence can have different settings which remain
independent of the setting of this measurement in the main window and in
other sequences. It is for example possible to compile a sequence with a
number of stability margin tests having different loop gain.

The titles of the tests and the messages displayed to the operator before
start of the measurement can also be edited in the “Parameters” window.

To facilitate copies of test definitions with small adaptations, it is possible to
store a copy of the current parameter set under a different file name (button
“Save copy”). Each measurement definition must have a unique title to be
distinguished from other definitions like for example the original from which
the copy was made.

For the purpose of making adapted copies it is possible to unlock a
standard test definition (uncheck the “Locked” checkbox). In this case the
“ok” button is disabled to avoid unintentional changes in standard tests.

All newly created test definitions appear in the last sub-menu of the
“Standards” menu” (“More...”).

Editing Parameters

Parameters can be edited by entering their number in the “number” field
below the data grid and clicking “Edit”.

Murnber I o

M ame

SLA upper limit [dE]

Type

I Drouble j

Default Walue
|11

[ Locked

Cancel | Ok I
Y

o

Fig. 55 Entry window for parameters

Note that the type conformity of the entered value is checked, but not the
value itself against any range limits.

Editing Limit Curves
Clicking “Add” or “Edit” below the data grid for the limit curves opens the
window for selecting limit files.

Note that currently “Desired” limit curves are not supported in all test
routines. Most of the measurement allow to specify either lower limits or
upper limits or both. An exception is formed by the sending response and
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receiving response measurements. As the limit template is centered around
the measured curve with these measurements, upper and lower mandatory
limits have to be specified pair-wise.

An existing limit file can be selected using the “browse” button. New limit
files can be created by copying an existing limit file and editing the copy with
a text editor (“Send to > Notepad” in the context menu of the file in the
windows explorer). The number of data points on the curve must be
specified in the “Datacount” line.

Template Curve
Mumnber |3
Mandatary upper limit

Mandatory lower limit

Desired upper limit
Desired lowe limit

Center curve

Upper tolerance  Lower
dE tolerance dB

D.DE: 1) DE:

File hame Browse
Cancel | Ok I

Fig. 56  Entry window for selecting limit curves
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7 Measurements with electric connections

1402.0043.12

Introduction

Usually the mobile under test is connected via RF connection to the CMU
and via acoustic interfaces (artificial mouth and ear) to the R&S UPV.
Therefore no intrusion in the mobile device is required.

There may, however, be cases during the design process of a mobile
phone where the usual interfaces are not available:

- if a mechanic mockup is to be measured just with the acoustic
components but without the rest of the circuitry

- if a circuit of a mobile phone is to be measured without acoustic
components

- if a hands free kit or headset is to be measured without mobile phone

- if the hands free or headset connection of a mobile phone is to be
measured without hands free kit or headset, respectively.

In these cases either coder and decoder or artificial ear and artificial mouth
may be replaced by direct electrical connections to the R&S UPV. To use
electric connections, select “Electric connection” in the respective item of
the “Options” menu.

Calibration values for electric connections

Electrical connections cannot be calibrated. Instead a virtual sensitivity has
to be entered for each type of electrical connection under “Calibration >
Electric connections > ...".

Electric connection replacing artificial ear

R&S UPV Analyzer input 1 is directly connected to the earpiece amplifier
output.

A nominal sensitivity of the receiver (earpiece speaker) for which the circuit
is intended has to be entered in dB re 1 Pa/V.
Electric connection replacing artificial mouth

R&S UPV generator output 1 is directly connected to the microphone input
of the mobile phone circuit.

A nominal sensitivity of the microphone for which the circuit is intended has
to be entered in dB re 1 V/Pa.
Electric connection replacing encoder

R&S UPV generator output 2 is directly connected to a earpiece or headset
speaker or to the speech input of a hands free kit.

A nominal full scale output voltage (output voltage corresponding to digital
full scale) of the circuit intended to drive the speaker or car kit has to be
entered.

Electric connection replacing decoder

R&S UPV analyzer input 2 is directly connected to a microphone or to the
speech output of a hands free kit.
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A nominal full scale input voltage (input voltage corresponding to digital full
scale) of the respective microphone or speech input has to be entered.

Performing the measurements

After applying the settings in the “Options” menu and after entering
appropriate calibration values for the electric connections in use, the
measurements may be started as usual.

Some parts of the standard require the use of particular artificial ears for
particular measurements. Therefore the checkbox “Allow only selected
measurements” should be unchecked in “Options - Standard”.

For sending tests, the output voltage range in the R&S UPV is set to a large
value in order to be able to drive the speaker of the artificial mouth. In rare
cases sending distortion and/or sending noise results may be degraded
with electric connections if a low microphone sensitivity is entered. In this
case please contact R&S support.
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8 Automatic Test Sequences

5. | Sequence Feport  Opl

1402.0043.12

Fig. 57 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.
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Fig. 58 Sequence window

Initially the right checked list box is empty. The tree view box on the left side
displays all available measurement definitions structured according to the
standards, similar to their order in the “Standards” menu. A measurement is
appended to the sequence by highlighting it in the tree view box on the left
side and clicking the “Append” button. Subsequently a measurement, which
is highlighted in the checked list box on the right side, can be moved within
the sequence using the buttons “Move up” and “Move down” and deleted
from the sequence with the “Delete X” button. For non-standard
measurements which allow to change parameters like limit curves, it is
possible to edit the parameters before appending the measurement to the
sequence. This is done by clicking the button “Edit and append”. It is for
example possible to assemble a test sequence which contains stability
margin tests with different loop gains.
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A sequence should be run with option “Show operator instructions”
disabled. This avoids interruption of the execution. If a message to the
operator is to be inserted into the sequence on purpose, e.g. “Set user
volume control to maximum!”, the items provided in the tree view under
“Messages and Control” may be used. Such a message will stop the
execution of the sequence until it is closed by acknowledgement of the
operator.

Opening an Existing Sequence

The menu item “Sequence - Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence file is usually found in a
subfolder of D:\3GPP with the same name as the sequence. The sequence
window opens with the specified sequence loaded. The sequence can then
be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox.

A running sequence may be interrupted with one of the buttons in the
measurement control window which is visible while a measurement is
running. “Cancel and continue sequence” cancels the currently running
measurement and resumes execution of the sequence with the next
measurement. “Cancel and stop sequence” aborts both running
measurement and sequence. “Stop sequence after this measurement”
completes the running measurement and stops the sequence afterwards.

&

Measuring
Distortion at -45 dBmd

Cancel and continue zequence

Cancel and stop sequence

Stap zequence after thiz
measurement

Fig. 59 Measurement control window

Running a Single Measurement out of a Sequence

A single measurement of a sequence may be started by highlighting the
measurement in the right checked list box and clicking the button “Run
Highlighted”.
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Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.
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Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

&S UPY-K9x Mobile P

File Data Calibration

Cpen resuls file
Save results
Save results as
Mew results file

Load settings
Save settings
Save settings as

Exit

Fig. 60 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File > Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Store results as” from the main menu.

Report Settings

With “Report > Settings” or “Options - Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

The size of diagrams in the report can be scaled between 100% (approx.
page width) and 50%.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left (see Fig. 11), right-clicking into the
data grid and selecting “Generate report” from the context menu.
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Subsequently data associated with the selected measurement is
assembled, a graph for existing curve data is generated, and the preview
window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Selection Report

A report on a selection of measurements can be generated from the results
overview data grid in the main window by marking the rows with the desired
results in the “Select” column and choosing item “Report Selection >
Report Selected Results” (see Fig. 10). Rows marked with “XXXXX” in the
“Select” column will be added to the report. The selection can be toggled by
clicking into the respective “Select” cells. Note that another cell must be
clicked before the same cell can be toggled again.

Preview Window

@)Repnrt !EE
& S | O T O o= oo B N

Main Repart I

a

3GPP Sending Handset videhand

&
FOHDEABCHNARE
Tl OYEONH ESLE e e R
[

1
\\

L |

‘Curremt Page Mo.: 1 |Tnta| Page Mo.: 1+ Zoom Factor: whaole Page

Fig. 61 Report preview window
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The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

P M
To open the print dialog for installed windows printers click
3

To open a file selector for export of the report to PDF, WORD, EXCEL or
Rich Text format, click

The scale of the document in the preview can be adjusted with

_ |whole Page — |
— 1400
300%
200%
150% o

[k -

Fig. 62 Scale menu of the preview window

Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K9/K91 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Shift Curve by 0= dB

Cancel | )3

3

Fig. 63 Input window for defining a shift of a measured curve for storage
as limit curve

Furthermore curves can be exported from the main results window by
marking the result in the data grid, right-clicking on it and choosing the item
“Save curve of selected row as ...” in the context menu.

ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu is
checked, the standard tests generate “curve.exp” or “abscurve.exp” and
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“relcurve.exp” and “result.exp” files similar to those generated by UPL-B9.
These files are always deleted and overwritten by subsequent tests.

This feature is provided only for compatibility reason. It is not available in all
measurement types.

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to a missing
call to the mobile, a wrong setting etc. To delete the result of a particular
measurement, mark the row for the selected measurement in the data grid
of the main window by clicking on the row header to the left, right-click into
the data grid and select “Delete result” from the context menu. After
confirmation by the operator, the selected row of the result overview will be
deleted from the result file together with all associated data.

A set of results may be selected in the “Select” column of the results data
grid and commonly deleted using the context menu item “Report Selection
- Delete Selected Results”.
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10 Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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Firmware 4.52

Settings for GSM:
Selection of the GSM band:

GSMQOO Overview

Ch. 2

E Menu Select

Connect
Control

— Selection ‘GSM Mobile Stationi®eM 900/Sighaling/OverviewPit Marmal GMSK |— Hotkeys - Set 1
¥ Basic Functions ¥ Mon-Signaling -+ AnatyzersGenerator R
. - . AnalyzerfGenerator
» 3G UMTS User Equipment > Signaling + Overview ]
+ AMPS Mobile Station AUDIO
T ZS Mobile Station AnalyzeriGenerator
* GSM 400 —_—¥
« 3SM 850 WCDMA UE FDD
Power
[ - Gemono Maximum
= GSM 1800 WCDMAUEFDD [l
+ (G5 1900 Modulation
+ IMT-2000 Mobile Station WEDMATOV eI icH
» TOA Mobie Station AMPS
AnalyzeriGenerator
Modulation
AMPS H
Overview
Modulation
Enter
Menu Hotkeys Hotkeys Hotkeys Hotkey I
Select Set1 Set 2| Set 3| Assign.l

Taking a coupling loss of the antenna coupler into account:

GSMQOO Overview

Ch. 2

Connect
Control

B GSMaoo Connection Control [g Signal On
AF Connector Overview: RF Connector Setup
AT AL RF
Analyzer 2 o o Generator 2 i 9 QU 372 7] 0utput
AFIN  AF OUT G
Analyzer 1 ° ° Generator 1 Ext. Att.
s &S +0.0 a8+15.0 uB +0.0 4B Cutput
Speech RF 41N RF 2 RF 1 RF
Encoder | Handset]3] G- Input
Speech Ext. Att.
Decoder | Handset]Y +00d6+15.0 B +0.0 dB Input
| — EWideband
Pk Power

Connection

MS Signal BS Signal | Network

nFIRF@»l Sync. |-. 2 ||
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Select EFR (full rate version 2), HR (half rate version 1), AMR full rate or
AMR half rate speech coder:

| GSMooo overview

B GSMaoo Connection Control [g

Full Rate Version 2 |
Full Rate Version 1

Full Rate Version 2

Half Rate Version 1
FullRate Data 4800
Full Rate Data 9600

Speechcod./Handset Low || |

| GSMooo overview

B GSMooo Connection Control [§ Signal On

Full Rate Version 2 ¥ |
Gl

MCST Test Mode
MCS8 Test Mode
MCS8 Test Mode
AMR FullRate

AMR Half Rate
Speechcod./Handset Low |_
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Selection of the Bit Stream Handset Low setting for the measurements or
Decoder Cal and Encoder Cal for the calibration:

| GSMooo overview

B GSMaoo Connection Control [g Signal On

Full Rate Version 2 | |

Speechcod./Handset Low || |
[G]

Speechcod./Handset

Speechcod./Handset Low

Codec Cal
Encoder Cal
Decoder Cal

| GSMooo overview

| 62 947.4 MHz
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Typical setting with EFR speech coder (corresponds to AMR 12.2) for
measurements in the call established status:

| GSMooo overview i ’

B GSMaoo Connection Control [B Call Established

Full Rate Version 2 |Ji |

Speechcod./Handset Low || |

Settings for WB-AMR:
GSMSOO Overview

B GSMooo Connection Control [ Signal On

Full Rate Version 2|
[C]

AMR Half Rate GMSK
AMR Half Rate 8BPSK

AMR-WB Full Rate GMSK

AMR-WB Full Rate 8PSK

AMR-WB Half Rate 8PSK

Speechcod./Handset Low |4
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Settings for UMTS WCDMA FDD:

Selection of mode:

| WCDMA Fop %™ Modulation

B Menu Select

t Connect
Control

— Selection ‘SG UMTS User Equiﬂ“famih\lCDMA FOCYSignalinoModulstion!. . . |— Hotkeys - Set 1
» Basic Functions » Mon-Signaling +Power RF
. - - AnalyzeriGenerator
~3G UMTS User Ecuipment |* Signaling +Modulation |
[+ WCDMAFDD Do)

+ AMPS Mobile Station AnalyzeriGenerator

+ GSM Mobile Station —_—

¥ IMT-2000 Mobie Station WCDHA LIE FDD

+ TDMA Mobile Station Maximum
WCDMA UEFDD  [F]
Modulation
WCDMA Overview
AMPS
AnalyzerfGenerator
Modulation
AMPS (|
Overview
Modulation

Enter
Menu HotKeys HotKeys HotKeys HotKey
Select Set 1 Set 2 Set 3 Assign.

Setting dedicated channel to voice:

| WCDMA Fop %™ Modulation

B WCDMArbD Connection Control

t Connect
Control

Signal On

RF Chn. Signal
Downink | 21124 miz|| 10562 |  MHaiting for ng |
e registration
or

E:Iﬁ‘rll(n. | 1922.4 MHzH 9512| call from the UE.
B

o TUtpUt G Fower
UE Power Dedlcated

33.0 dBm‘ \ -20.0 |:IBm| Voice u

Control Iax. all. LE-Pow: LIL Target Power RMC Channel

Expect. PRACH Powr

|
Openloop | I |
Power E PRACH UE-CrPaw

Signalling RAB

— Voice ‘
Enter

PRACH Signature

| Operating Band | ¥

Select

Cnnneclionl Handover | UE Signal | BS Signal | Hetwork | AF!RFG" Sync. |.- 2 II
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Selection of the Narrowband AMR Speechcodec Low setting and AMR Bit
Rate for the measurements or Decoder Cal and Encoder Cal for the
calibration (selection is possible only if call is deactivated):

@ WCDMA FoD Ba:"d Modulation -ég |g::?:;t

& WCDMAFDD Conhection Control [B S: CS: Signal On
}f“lrcult Switched/Voice Settings/. .. |,—
Waice Source Speechcodec Low
Active Coder [NE AMR
[t
Active Codec Set Selection A [Compress]

Codec Modes [ 475 kops
[ s15khps
[ sommps
[ s7kops
[ 74wps
[ 795 kps =
[T 102keps
12,2 kops

* IAIB Adaptive MUt Rate (A8 AMR)
~ Signaling RAE Settings

Cnnnectinnl Handowver | UE Signal BS Signal | Network | AFIRFG'l Sync. |.- 3 II

3GPP Ts 26.132 specifies 12.2 kbps bit rate for audio testing with the NB
AMR codec.

Selection of the Wideband AMR Speechcodec Low setting and AMR Bit
Rate for the measurements or Decoder Cal and Encoder Cal for the
calibration (selection is possible only if call is deactivated). 3GPP TS 26.132
specifies 19.85 kbps for audio with the WB AMR codec:

@ WCDMA FDD Ba:nd Modulation

Connect
Control

B WCDMAFDD Connection Control Jg

—Setup |circuit SwitchedVoice Settings |E

Voice Source Speechcodec Low [Comgress]

Active Coder B AMR
» Adaptive Muti Rate (NB AMR)
ulti B

Active Codec Set Selection C

Codec Modes [] Ep0khps
[ saskbes
[ ] 1265kops
[T 1425kps
[ 1585 ks
[T 1825kmps
19,35 kbps
[ 2305k0ps
[ 2385 ko=

Connection | Handower UE Signal BS Signal | Network | AFIRFG'l Sync. |.- 3 II
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Mobile phone registered status, codec settings possible:

F WCDMA rFop Balnd Modulation é '_h ’7

B WCDMArbD Connection Control Registered

| 2112.4 muz 10562
| 1922.4 MH:z 9612

|

| | Voice[Y |
0
| q
F
OperatingBand | || |

2|

Call active (connected) status for the measurements:

Ch. 1 WCDMA Fop Balnd Modulation ’

Bl WCDMA D Connection Control [ Connected

| 2112.4 muz 10562
| 1922.4 MH:z 9612

|

| |
0

| gl = —
F

OperatingBand | || |

2|

1402.0043.12 83 E-4



Acoustic Measurements on Mobile Phones

Appendix B Troubleshooting

1402.0043.12

Damaged setup file is reported

If the program is unable to load the latest setup file, it will automatically offer
to restore a backup of the damaged file. Only if there is no backup
available, or loading of the backup fails again, the following procedure can
be applied:

Copy “Settings.sup” from C:\Program Files\Rohde&Schwarz\UPV-K9x
Mobile Phone Tests” to “D:\3GPP”, overwriting the damaged file of the
same name. Alternatively, “D:\3GPP\settings.sup” may just be deleted.
Subsequently all settings in the “Options” menu have to re-done and for all
used calibration types calibrated devices have to be selected again.

Damaged results file is reported

There are backup files available of the file containing the test results, with
appendix ~1 and ~2 to the file name of the results file (usually
“D:\3GPP\Results.xml”). If the results file cannot be opened for some
reason, the program automatically offers to restore the latest backup file.

If this does not work, a backup file can be renamed by removing the
respective ~1 or ~2 extension, and opened subsequently. It is
recommended to store the damaged results file under a different name.

A test is not starting properly

Re-select devices for the calibration types required for the respective test,
using menu item Calibration = Select device. If this does not solve the
problem, copy all files from “C:\Program Files\Rohde&Schwarz2\UPV-K9x
mobile phone tests\3GPP files\Overwrite” to “D:\3GPP”, overwriting the
existing files therein.

A calibration value is missing or no device is selected for
a required calibration type

If re-selecting the calibration device and re-calibrating it does not help,
create a new device with “Calibration - New device”. Tick the “Immediately
select this device” box before clicking the “Ok” button and do the calibration
for this device. All selected devices and their calibration values can be
checked with “Calibration > Show selected devices”.

The receiving noise test produces an overrange error

Reduce the gain of the conditioning amplifer in the signal path of the
artificial ear, re-calibrate the artificial ear and re-try the test.
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ARL for the sending distortion test cannot be adjusted

First, try a sending test to see if the connection to the mobile is existing. If
the RLR value is too high, the sending sensitivity of the mobile under test
may be too low to adjust the ARL. If there is no signal in the sending test
(SLR > 60 dB) check the connection between CMU and mobile. If no signal
from the artificial mouth is audible during the sending test, check the signal
path between R&S UPV and artificial mouth. Re-calibrate the artificial
mouth.

Other problems of unknown reason

If the problem cannot be solved with the information given above, the folder
“D:\3GPP” can be renamed or deleted. At the next start of the application,
this folder is created anew with all files in default state.

Attention: Store a backup copy of the results file in a different folder before
deleting “D:\3GPP”.

Note: Subsequently all settings in the Options menu and all data
entries have to be re-done, all calibrated devices have to be
created and calibrated again.
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